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A jelen útmutató több terméktípusra vonatkozik, nem egy bizonyos termék leírását tartalmazza.



 

 Az olyan bizonytalanságok miatt, mint például a fizikai környezet, eltérések lehetnek az aktuális 
értékek, illetve az ebben a kézikönyvben feltüntetett referenciaértékek között. A végső értelmezés 
joga a cégünknél marad. 

Környezetvédelem 
Ezt a terméket úgy terveztük, hogy megfeleljen a környezetvédelmi előírásoknak. A termék megfelelő 
tárolására, használatára és ártalmatlanítására vonatkozóan be kell tartani az adott ország törvényeit és 
előírásait. 
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Szimbólum Leírás 

FIGYELMEZTETÉS! 
Fontos biztonsági utasításokat tartalmaz, és jelzi a személyi sérülés veszélyével 
járó helyzeteket. 

 FIGYELEM! 
Azt jelzi, hogy óvatosság szükséges, és a nem megfelelően végzett műveletek a 
termék károsodásához vagy hibás működéséhez vezethetnek. 

MEGJEGYZÉS! A termék használatával kapcsolatos hasznos vagy kiegészítő információkat jelöl. 
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1 

1  Hálózatba kapcsolás 

Ahhoz, hogy a hálózati kamera (IP-kamera vagy IPC néven is ismert) elérhető legyen, közvetlenül vagy 
switchen, illetve útválasztón keresztül egy hálózati kábel segítségével össze kell kötni egy számítógéppel. 

 
A hálózati kamera és a számítógép hálózati interfészeinek összekötéséhez árnyékolt csavart érpárú (STP) 
kábelt használjon. 

 

A kamera és a switch vagy útválasztó hálózati interfészeinek összekötéséhez árnyékolt csavart érpárú (STP) 
kábeleket használjon. 

2  Bejelentkezés 

Előkészítés 
A Gyors útmutató alapján történő telepítés befejezését követően a kamerát a tápfeszültséghez kapcsolva 
kapcsolja be. A kamera indítását követően a kamera egy telepített webböngészővel vagy a GuardStation 
kliensszoftverrel rendelkező számítógépről érhető el. Az ajánlott webböngésző az Internet Explorer (IE). A 
GuardStation szoftverrel kapcsolatos további információkat a GuardStation felhasználói kézikönyvében 
talál. 
Az alábbiakban a Microsoft Windows 7.0 operációs rendszerre telepített IE böngésző szerepel példaként. 

Mielőtt hozzákezd, ellenőrizze a következőket 

 A kamera megfelelően működik. 

 A számítógép és a kamera közötti hálózati kapcsolat megfelelő. 

 A számítógépen telepítve van az Internet Explorer 8.0 vagy újabb böngésző. 

 (Opcionális) A felbontás 1440 x 900 képpontra van állítva. 

Hálózati kábel 

Hálózati kábel 

Switch vagy útválasztó 

Hálózati kábel

SzámítógépIPC 

SzámítógépIPC 
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Vegye fel az IP-címet a megbízható helyek listájára 

1

2
 

http://192.168.0.13

3
4

5

6
Clear the check box

7
 

Szüntesse meg a jelölőnégyzet 
bejelölését 
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 MEGJEGYZÉS! 
A példában szereplő 192.168.0.13/192.168.1.13 az alapértelmezett IP-cím. Cserélje ki a kamera tényleges 
címével, amennyiben az módosítva lett. 

 

(Opcionális) Módosítsa a felhasználói fiókok felügyeletének beállításait 

A kamera eléréséhez az alábbi lépéseket követve a User Account Control Settings beállításnál válassza a 
Never notify lehetőséget. 

 

Bejelentkezés a webes felületre 
A kamera alapértelmezett statikus IP-címe 192.168.1.13 vagy 192.168.0.13, az alapértelmezett alhálózati 
maszk pedig 255.255.255.0. 

A DHCP-szolgáltatás alapértelmezett esetben ki van kapcsolva. Ha a hálózatban van DHCP-kiszolgáló, akkor 
előfordulhat, hogy a kamera IP-címe automatikusan kerül kiosztásra, és a bejelentkezéshez a tényleges 
IP-címet kell használnia. A kamera dinamikus IP-címét a GuardStation kliensszoftverben tudja megnézni. 

Az alábbiakban az IE böngésző szerepel példaként a bejelentkezési művelet leírásához. 

1. A kamera tényleges IP-címét a címsávba beírva nyissa meg a bejelentkezési oldalt. 

 

2. Ha először jelentkezik be, akkor a rendszer kérdéseit követve telepítse az ActiveX szolgáltatást.  
A telepítés befejezéséhez be kell zárnia a böngészőt. 
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 MEGJEGYZÉS! 
 Az ActiveX kézi betöltéséhez írja be a címsávba a http://IP-cím/ActiveX/Setup.exe parancsot, majd 

nyomja meg az Enter billentyűt. 
 Az alapértelmezett jelszó az első bejelentkezéskor használható. A fiók biztonsága érdekében az első

bejelentkezést kővetően változtassa meg a jelszót. Javasoljuk, hogy erős (legalább nyolc 
karakterből álló) jelszót használjon. 

 A kamera a sikertelen bejelentkezési kísérletek korlátozásával biztosítja saját védelmét. Ha a
bejelentkezés egymást követő hat alkalommal sikertelen, akkor a kamera tíz percre automatikusan 
zárolja magát. 

 

3. Adja meg a felhasználónevet és a jelszót, majd kattintson a Login elemre. Első bejelentkezéskor 
használja az alapértelmezett „admin” felhasználónevet és „123456” jelszót. 

 Ha a Live View opció kiválasztásával jelentkezik be, akkor a bejelentkezést követően az élő videokép 
lesz látható. Ellenkező esetben az élőkép ablakban kézzel kell elindítania az élő videoképet. 

 Ha bejelölt Save Password opció mellett jelentkezik be, akkor nem kell minden bejelentkezéskor 
megadnia jelszavát. A biztonság érdekében nem javasoljuk a Save Password opció bejelölését. 

 A Username és Password szövegmezők törléséhez, valamint a Save Password bejelölésének 
megszüntetéséhez kattintson a Reset elemre.  

A webes felület bemutatása 
A webes felületre történő bejelentkezést követően alapértelmezett esetben az élőkép jelenik meg. Az 
alábbiakban egy példát láthat. 

1

2

3

4  

Sz. Leírás 

1 Menü 

2 
PTZ-vezérlési terület 

Megjegyzés: 
Ez a terület PTZ dómkamerák és PTZ kamerák esetén érhető el. 

3 Élőkép ablak 

4 Élőkép eszköztár 
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Kezdeti konfiguráció 
Az eszközre történő bejelentkezést követően végezze el az alábbi kezdeti beállításokat. 

Tétel Leírás 

1. Az eszköz TCP/IP-címének beállítása. Az eszköz IP-és hálózati konfigurációjának módosítása a 
tényleges hálózati környezetnek megfelelően. 

2. Jelentkezzen ki, majd ismét be az új 
IP-címmel. - 

3. A rendszeridő beállítása. Rendszeridő tényleges körülmények szerinti beállítása. 

4. (Opcionális) Kezelési kiszolgáló 
beállítása. 

A kezelési kiszolgáló beállítása a tényleges hálózati 
környezetnek megfelelően. 

5. (Opcionális) A fotók tárolására 
használt kiszolgáló beállítása. 

A fényképeket tároló kiszolgáló beállítása a tényleges hálózati 
környezetnek megfelelően. 

6. Az OSD beállítása. A képernyőn megjelenített információk, például idő igény 
szerinti beállítása. 

7. (Opcionális) Felhasználók kezelése. Az alapértelmezett jelszó módosítása és szükség szerint normál 
felhasználók hozzáadása. 

 

A kezdeti beállítások befejezését követően már láthatja az élő videoképet. Szükség szerint állítsa be a többi 
paramétert is. 

 MEGJEGYZÉS! 
 A megjelenített élőkép felület, a megjelenített paraméterek és értéktartományok típustól függően

változnak. A részletekért lásd a tényleges webes felületet. 
 A kiszürkített paraméterek nem módosíthatók. A tényleges beállításokra vonatkozóan lásd a webes 

felületet. 
 Az első bejelentkezést követően javasoljuk a jelszó módosítását. A jelszó módosításának részleteire

vonatkozóan lásd: Biztonság. 

 

3  A paraméterek beállítása 

Helyi paraméterek 
Itt állíthatja be a számítógép helyi paramétereit. 

 MEGJEGYZÉS! 
A helyi paraméterek típusonként változhatnak. A részletekért lásd a tényleges webes felületet. 

 

1. Válassza a Setup > Common > Local Settings lehetőséget. 
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2. Szükség szerint módosítsa a beállításokat. A következő táblázat néhány bőbb paramétert mutat be. 

Paraméter Leírás 

Intelligent 
Mark 

Untriggered 
Target 

Ha engedélyezve van, a kamera megjelöli a képernyőn a célpontot 
(pl. az arcérzékelés bekapcsolása esetén egy arcot), majd követi azt. 

Processing Mode 

 Valós idejű prioritás: Jó hálózatminőség esetén ajánlott. 
 Folyamatosság prioritása: Akkor ajánlott, ha kis késleltetést kíván elérni az 

élő videoképen. 
 Nagyon alacsony késleltetés: Akkor ajánlott, ha a lehető legkisebb 

késleltetési időt kívánja elérni az élő videoképen. 

Video 

Protocol A számítógép által dekódolni kívánt adatfolyamok protokolljának beállítása. 

Recording 

 Alszakasz idő szerint: A számítógépen tárolt fájlokban rögzített videók 
időtartama. Például: 2 perc. 

 Alszakasz méret szerint: A számítógépen tárolt egyes felvételfájlok 
mérete. Például: 5 M. Record 

and 
Snapshot 

Record 
Overwrite 

 Felülírás: Ha a kijelölt tárhely a számítógépen megtelik, a kamera törli a 
meglévő felvételfájlokat, hogy helyet biztosítson az új felvételi fájl 
számára. 

 Teljes leállítás: Ha a kijelölt tárhely a számítógépen megtelik, a felvétel 
automatikusan leáll. 

 

3. Kattintson a Save lehetőségre. 
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A hálózat konfigurálása 

Ethernet 

Itt adhatja meg a kamera kommunikációs beállításait, például IP-címét annak érdekében, hogy a kamera 
kommunikálni tudjon a többi eszközzel. 

 MEGJEGYZÉS! 
 Az IP-cím módosítását követően az új IP-címen kell bejelentkezni. 
 A DNS- (Domain Name System - domainnévrendszer) kiszolgálóra az eszköz domainnév alapján

történő elérésekor van szükség. 

 

Statikus cím 

1. Kattintson a Setup > Network > Network lehetőségekre. 

  
2. Az Obtain IP Address legördülő listában válassza a Static lehetőséget. 

3. Adja meg az IP-címet, az alhálózati maszkot és az alapértelmezett átjáró címét. Ügyeljen arra, hogy a 
kamera IP-címe egyedi legyen a hálózaton belül. 

4. Kattintson a Save lehetőségre. 

PPPoE 

 MEGJEGYZÉS! 
Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típust. 

 

Ha a kamera PPPoE- (Point to Point over Ethernet – pont-pont közötti protokoll Etherneten keresztül) 
kapcsolaton keresztül csatlakozik a hálózathoz, akkor az a PPPoE lehetőséget kell az IP-címkiosztás 
módjaként kiválasztania. 

1. Kattintson a Setup > Network > Network lehetőségekre. 
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2. Az Obtain IP Address legördülő listában válassza a PPPoE lehetőséget. 

3. Adja meg az internetszolgáltatójától (ISP) kapott felhasználónevet és jelszót. 

4. Kattintson a Save lehetőségre. 

DHCP 
A dinamikus állomáskonfiguráló protokoll (Dynamic Host Configuration Protocol – DHCP) alapértelmezett 
esetben gyárilag engedélyezve van a kamerán. Ha a hálózaton működik DHCP-kiszolgáló, akkor a 
DHCP-kiszolgáló automatikusan tud IP-címet kiosztani a kamera számára. 

A DHCP kézi beállításához kövesse az alábbi lépéseket: 

1. Kattintson a Setup > Network > Network lehetőségekre. 

 

2. Az Obtain IP Address legördülő listában válassza a DHCP lehetőséget. 

3. Kattintson a Save lehetőségre. 

IPv6 

1. Kattintson a Setup > Network > Network lehetőségekre. 
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2. Az IPv6 alapértelmezett esetben Manual beállítású. 

3. Az IPv6 cím megadásához állítsa be az előtag hosszát és az alapértelmezett átjárót. Az IP-címnek 
egyedinek kell lennie a hálózaton belül. 

4. Kattintson a Save lehetőségre. 

WiFi 

 MEGJEGYZÉS! 
Ezt a funkciót egyes típusok nem támogatják, részletekért lásd a tényleges típust. 

1. Kattintson a Setup > Network > Network lehetőségekre. Kattintson a Wi-Fi fülre. 

 
2. Válassza a Sniffer lehetőséget. 

3. Kattintson a Save lehetőségre. 

Egyes eszközök képesek megkeresni a Wifi-hálózatokat és kapcsolódni azokhoz. 

1. Válassza a Setup > Network > Network lehetőséget. A Wi-Fi Mode beállításnál válassza a Wi-Fi opciót. 

 

2. Megjelenik a jelerősség. Kapcsolja be az Adaptive Streams funkciót. Az oldalon látszik, hogy más 
Wifi-hálózatok is elérhetők. A Wifi-hálózatok újbóli kereséséhez kattintson a Search elemre. 

3. Kattintson egy SSID-azonosítóra a Wifi-hálózatok listájában. Megjelennek az érintett hálózat adatai. 

4. Kattintson a Save lehetőségre. 



10 

5. Ha a Wi-Fi Mode beállítása Wi-Fi Hotspot, akkor a kamera képes Wifi hozzáférési pontként működni a 
többi eszköz számára. 

 

6. Kattintson a Save lehetőségre. 

Port 

 MEGJEGYZÉS! 
Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típust. 

1. Kattintson a Setup > Network > Port elemre. 

 
2. Állítsa be a vonatkozó portszámokat. 

3. Kattintson a Save lehetőségre. 

FTP 

Az FTP beállítását követően pillanatfelvételeket tölthet fel a hálózati kamerákról az FTP-kiszolgálóra. 

Általános 

1. Kattintson a Setup > Storage > FTP lehetőségre Lépjen a General fülre. 
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2. Állítsa be az FTP-kiszolgáló IP-címét és portszámát, a képek FTP-kiszolgálóra történő feltöltéséhez 

használt felhasználónevet és jelszót, jelölje be az Upload Images, Overwrite Storage 
jelölőnégyzeteket, majd állítsa be az Overwrite At értékét (a képek felülírási küszöbértékét). Egyes 
kameratípusok támogatják az FTP-tesztet. Az FTP-beállítások megfelelő elvégzését követően 
tesztelheti az FTP-kiszolgálót. 

3. Állítsa be a pillanatfelvételek mentési útvonalát az FTP-kiszolgálón, valamint a fájlnév formátumát. 
Például beállíthat egy Preset száma\\IP-cím\\Dátum\\Óra útvonalat, a fájlnév pedig lehet Preset 
száma-PTZ Zoom-PTZ szélesség-PTZ hosszúság.jpg. 

4. Kattintson a Save lehetőségre. 

Smart 
Ez a funkció az intelligens funkciók, például arcfelismerés vagy személyszámlálás által rögzített 
pillanatfelvételek tárolására szolgál. 

1. Kattintson a Setup > Storage > FTP lehetőségre Lépjen a Smart fülre. 
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2. Állítsa be az FTP-kiszolgáló IP-címét és portszámát, a képek FTP-kiszolgálóra történő feltöltéséhez 

használt felhasználónevet és jelszót. 

3. Állítsa be a pillanatfelvételek mentési útvonalát az FTP-kiszolgálón, valamint a fájlnév formátumát. 
Például beállíthat egy Preset száma\\IP-cím\\Dátum útvonalat, a fájlnév pedig lehet Preset száma-PTZ 
szélesség-PTZ hosszúság-PTZ Zoom.jpg. 

4. Kattintson a Save lehetőségre. 

E-mail 

Az e-mail beállítását követően riasztás esetén üzeneteket küldhet a megadott e-mail címre. 

1. Kattintson a Setup > Network > E-mail elemre. 
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2. Állítsa be a feladó és a címzett megfelelő adatait. Egyes kameratípusok támogatják az e-mail tesztet.  

A címzett címének beállítását követően tesztelheti az e-mail funkciót. A következő táblázat néhány 
bőbb paramétert mutat be. 

Paraméter Leírás 

TLS/SSL 

Ha engedélyezve van, akkor a személyes adatok védelme érdekében az e-mailek küldése 
TLS (Transport Layer Security) vagy Secure Socket Layer (SSL) titkosítással történik. 

A kamera először megkísérli az SSL-kapcsolaton keresztüli küldést. Ha az SMTP-kiszolgáló 
támogatja azt SSL protokollt, akkor ez e-mail küldése SSL-kapcsolaton keresztül történik, 
ellenkező esetben a kamera megkísérli a STARTTLS segítségével történő küldést. 

Attach Image Ha engedélyezve van, akkor az e-mail a beállított felvételi időköznek megfelelően 
3 pillanatfelvételt tartalmaz mellékletként. 

 

3. Kattintson a Save lehetőségre. 

Port átirányítása  

1. Kattintson a Setup > Network > Port elemre. Lépjen a Port Mapping fülre. 
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2. Engedélyezze a Port Mapping funkciót, majd válassza ki a leképezés típusát. A Manual opció kiválasztása 
esetén be kell állítani a külső portokat (a kamera automatikusan lekéri a külső IP-címet). Ha a beállított 
port foglalt, akkor a Status értéke Inactive. 

3. Kattintson a Save lehetőségre. 

DNS 

1. Kattintson a Setup > Network > DNS elemre. 

 

2. Állítsa be a DNS-kiszolgáló címét. 

3. Kattintson a Save lehetőségre. 

DDNS  

 MEGJEGYZÉS! 
Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típust. 

 

1. Kattintson a Setup > Network > DDNS elemre. 

 
2. Engedélyezze a DDNS Service szolgáltatást. 

3. Válassza ki a DDNS típusát: DynDNS, NO-IP vagy EZDDNS. 

4. Végezze el a többi beállítást, például a kiszolgálócím, domainnév, felhasználónév, valamint jelszó 
beállítását. 

5. Kattintson a Save lehetőségre. 

P2P - Star4live.com 

 MEGJEGYZÉS! 
 Ez a funkció nem minden típuson érhető el. 
 Egyes eszközökön ez a funkció EZCloud néven jelenik meg. 

 

1. Kattintson a Setup > Network > P2P lehetőségre. 
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2. A felhőszolgáltatás engedélyezéséhez válassza az On lehetőséget. 

3. Kattintson a Save lehetőségre. 

802.1x 

A 802.1x hitelesítési lehetőséget biztosít a hálózathoz kapcsolódni próbáló eszközök (például kamerák) 
számára. A hálózathoz csak hitelesített eszközök kapcsolódhatnak. Ez növeli a biztonságot. 

1. Kattintson a Setup > Network > 802.1x lehetőségre. 

 
2. Válassza az On lehetőséget, majd végezze el a többi beállítást. 

3. Kattintson a Save lehetőségre. 

A kép konfigurálása 

Képbeállítás 

 MEGJEGYZÉS! 
 A kép megjelenített paraméterei és a megengedett értéktartományok kameratípusonként

változhatnak. A kamerájára ténylegesen érvényes paraméterekkel és értéktartományokkal
kapcsolatban lásd a webes felületet. A beállítások módosításához mozgassa a csúszkákat, vagy
közvetlenül is beírhat értékeket. 

 A Default elemre kattintva visszaállíthatja az alapértelmezett képbeállításokat. 

 

A helyszín beállítása 

Az egyes helyszínek alapján beállíthatja kívánt képhatások eléréséhez szükséges képparamétereket. 

Kattintson a Setup > Image > Image lehetőségre. 

Egyes típusok helyszínkezelési oldala az alábbiaknak megfelelően jelenik meg, a legördülő listából 
választhatja ki a kívánt helyszínt. 
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Egyes típusok helyszínkezelési oldala az alábbiaknak megfelelően jelenik meg, az alábbi lépések 
segítségével állíthatja be a helyszínt. 

 
1. Kattintson a Scenes elemre. 

2. Válasszon egy helyszínt, majd állítsa be a helyszínváltási paramétereket. A következő táblázat néhány 
bőbb paramétert mutat be. 

Oszlop Leírás 

Current 

Az alkalmazott helyszínt jelöli. 

Megjegyzés: 
 Válasszon egy opciógombot az adott helyszínre váltáshoz és a helyszínhez tartozó 

képparaméterek megjelenítéséhez. 
 Az Enable Auto Switching bejelölése esetén a kamera automatikusan vált az aktuális 

helyszínek között. 

Scene Name 

Az aktuális helyszín neve. Az eszköz többféle előbeállított helyszínüzemmódot kínál. Egy 
helyszín kiválasztásakor megjelennek a hozzá tartozó képparaméterek. A képbeállításokat 
igényei szerint módosíthatja. 

 Common: kültéri helyszínekhez ajánlott. 
 Indoor: beltéri helyszínekhez ajánlott. 
 High Sensitivity: gyenge megvilágítású környezethez ajánlott. 
 Csúcsfénykompenzáció: csökkenteni képes az erős fények, például az úton a fényszórók 

vagy parkokban a reflektorok hatását. Járművek rendszámainak leolvasásához ajánlott. 
 WDR: erős kontrasztú megvilágítással rendelkező helyszínekhez ajánlott, például 

ablakoknál, folyosókon, bejárati ajtónál vagy egyéb olyan helyszíneken, ahol erős külső 
és gyenge belső megvilágítás van jelen. 

 Custom: szükség szerint beállíthat egy helyszínnevet. 
 Arc: Mozgásban lévő arcok összetett helyszínen történő rögzítéséhez. 

Auto 
Switching 

Azt jelöli, hogy egy helyszín szerepeljen-e az automatikus váltási listában. 

Megjegyzés: 
Ha az Auto Switching be van jelölve, akkor a rendszer a helyszínváltás feltételeinek 
teljesülése esetén automatikusan vált egy helyszínre. Alapértelmezett esetben az 
alapértelmezett helyszín szerepel az automatikus váltási listában. 

Setup 

A  elemre kattintva állíthatja be az automatikus váltás feltételeit, beleértve az ütemezést, 
megvilágítást, az aktuális emelkedési szöget (a PTZ és a vízszintes irány közötti szöget). Ez 
azt jelenti, hogy az automatikus váltás csak akkor történik meg, ha a beállított időszakon 
belül a megvilágítás és az aktuális emelkedési szög teljesíti a beállított feltételeket. A feltétel 
érvénytelen, ha a kezdő és záró érték is 0. 
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3. Egy helyszín alapértelmezettként történő beállításához válassza ki a helyszínt, majd kattintson a  
elemre. 

4. Ha az automatikus váltás engedélyezve van, akkor a nem alapértelmezett helyszínre történő váltás 
feltételének teljesülése esetén a kamera automatikusan tud helyszínt váltani. Ellenkező esetben a 
kamera az alapértelmezett helyszín beállításainál marad. Ha az automatikus váltás nincs engedélyezve, 
a kamera az aktuális helyszín beállításainál marad. 

 MEGJEGYZÉS! 
 Ha az automatikus váltás engedélyezve van (a helyszínbeállítások nem lesznek elérhetőek), akkor

az eszköz a beállított helyszínek között fog váltani. Ellenkező esetben az eszköz az aktuális helyszín
beállításainál marad. Az eszköz az alapértelmezett helyszín beállításainál marad, amíg egy nem
alapértelmezett helyszínre váltás nincs kezdeményezve. 

 Több nem alapértelmezett helyszín kezdeményezése esetén az eszköz a legalacsonyabb számú
(1-től kezdődően, 5-ig) helyszín beállításaira vált. 

 

Képjavítás 

 MEGJEGYZÉS! 
Ez a funkció típusonként eltérő lehet. A részletekért lásd a tényleges webes felületet.  

 

1. Kattintson a Setup > Image > Image elemre, majd az Image Enhancement lehetőségre. 

 
2. A csúszkákkal módosíthatja a beállításokat. Közvetlenül is beírhat értékeket. A következő táblázat 

néhány bőbb paramétert mutat be. 

Tétel Leírás 

Brightness 

A képek fényerejének beállítása. 

  

Alacsony fényerő Magas fényerő  

Saturation 

Egy színben lévő színtartalom mennyisége. 

  

Alacsony telítettség Magas telítettség  
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Tétel Leírás 

Contrast 

A legfeketébb és legfehérebb képpont közötti különbség mértékének beállítása. 

  

Alacsony kontraszt Magas kontraszt  

Sharpness 

A tárgyak széleinek a kontrasztja egy képen. 

  

Alacsony 
élességbeállítási érték 

Magas 
élességbeállítási 

érték  
2D Noise 
Reduction Csökkenti a képzajt. A funkció a kép elmosódását okozhatja. 

3D Noise 
Reduction 

Csökkenti a képzajt. A funkció mozgási elmosódást (vagy egyes alkalmazásoknál 
szellemképet) okozhat. 

Image 
Rotation 

A kép elforgatása.  

  

Normál Függőleges tükrözés 

  

Vízszintes tükrözés 180° 
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Tétel Leírás 

  

90° az óramutató járásával 
megegyező irányban 

90° az óramutató járásával ellentétes 
irányban  

 

3. Az ezen a területen található beállítások visszaállításához kattintson a Default lehetőségre. 

Expozíció 

 MEGJEGYZÉS! 
 Ez a funkció típusonként eltérő lehet. A részletekért lásd a tényleges webes felületet. 
 Az alapértelmezett beállítások helyszínenként külön érvényesek. Ha nincs szükség módosításra,

használja az alapértelmezett beállításokat. 

 

1. Kattintson a Setup > Image > Image elemre, majd az Exposure lehetőségre. 

 
Egyes kameratípusok esetén az oldal az alábbiaknak megfelelően néz ki. 
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2. Állítsa be a paramétereket az igényeknek megfelelően. A következő táblázat néhány bőbb paramétert 
mutat be. 

Paraméter Leírás 

Exposure 
Mode 

Itt kiválaszthatja a megfelelő expozíciós módot a kívánt expozíciós hatás eléréséhez. 

 Automatikus: A kamera a környezetnek megfelelően, automatikusan állítja be az 
expozíciót. 

 Egyéni: A felhasználó állítja be a szükséges expozíciós értéket. 
 Beltéri 50 Hz: A zárfrekvencia korlátozásán keresztül csökkenti a csíkozódást. 
 Beltéri 60Hz: A zárfrekvencia korlátozásán keresztül csökkenti a csíkozódást. 
 Kézi: A képminőség finomhangolása a záridő, erősítés és rekesz kézi beállításával. 
 Kis mozgási elmosódás: A minimális zársebesség szabályozása a rögzített mozgó arcok 

elmosódásának csökkentése érdekében. 

Shutter (s) 

A zár szabályozza a lencséhez eljutó fényt. A gyors zársebesség ideális a gyors mozgással 
járó helyszíneken. A hosszú záridő lassan változó helyszíneken ideális. 

Megjegyzés: 
 A zársebesség akkor állítható, ha az Exposure Mode beállítás Manual vagy Shutter 

Priority értékre van állítva.  
 Ha a Slow Shutter beállítás Off értékre van állítva, akkor a zársebességnek nagyobbnak 

kell lennie, mint képfrissítési frekvencia. 

Gain (dB) 

Úgy szabályozza a képjeleket, hogy a kamera a fényviszonyoknak megfelelő videojeleket 
generáljon. 

Megjegyzés:  
Ez a paraméter csak akkor állítható, ha az Exposure Mode beállítás Manual vagy Gain 
Priority értékre van állítva. 

Slow Shutter 

Javítja a kép fényerejét gyenge fényviszonyok között. 

Megjegyzés:  
Ez a paraméter csak akkor állítható, ha az Exposure Mode beállítás nem Shutter Priority 
értékű és a Image Stabilizer le van tiltva. 

Slowest 
Shutter 

A kamera által az expozíciókor használható leghosszabb záridőt állítja be. 

Megjegyzés:  
Ez a paraméter csak akkor állítható, ha a Slow Shutter beállítása On. 

Compensation 
Itt állíthatja be a kívánt hatáshoz szükséges kompenzációs értéket. 

Megjegyzés:  
Ez a paraméter csak akkor állítható, ha az Exposure Mode beállítása nem Manual. 
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Paraméter Leírás 

Metering 
Control 

Itt állíthatja be a kamera általi fénymérés módját. 

 Középre súlyozott átalagmérés: Elsősorban a kép középső részén méri a fényt. 
 Kiértékelő mérés: A fény mérése a kép egyénileg beállított területén történik. 
 Csúcsfénykompenzáció: A kép túlexponált részeinek figyelmen kívül hagyása. Ez funkció 

azonban csökkenti a kép általános fényerejét. 
 Arcmérés: Gyenge megvilágítás mellett a rögzített arc környezeti fényerejének 

szabályozásával állíthat a képminőségen. 
Megjegyzés:  
Ez a paraméter csak akkor állítható, ha az Exposure Mode beállítása nem Manual. 

Day/Night 
Mode 

 Automatikus: A kamera a fényviszonyoktól függően optimális képeket ad. Ebben az 
üzemmódban a kamera automatikusan vált az éjszakai és nappali mód között. 

 Éjszakai: A kamera a meglévő megvilágítás mellett optimális fekete-fehér képeket ad 
 Nappali: A kamera a meglévő megvilágítás mellett optimális színes képeket ad. 

Day/Night 
Sensitivity 

A fényerő küszöbértéke, amelynél a kamera átvált a nappali és az éjszakai mód között. 
A nagyobb érzékenység azt jelenti, hogy a kamera érzékenyebb a fényváltozásokra, 
és könnyebben vált át a nappali és éjszakai mód között. 

Megjegyzés: 
Ez a paraméter csak akkor állítható, ha a Day/Night Mode beállítása Automatic. 

Day/Night 
Switching(s) 

Itt állíthatja be azt az időt, amely leteltével a kamera átvált a nappali és éjszakai mód között, 
amennyiben a váltás feltételei teljesülnek. 

Megjegyzés: 
Ez a paraméter csak akkor állítható, ha a Day/Night Mode beállítása Automatic. 

WDR 

A képen belüli világos és sötét részek elkülönítéséhez engedélyezze a WDR funkciót. 

Megjegyzés:  
Ez a paraméter csak akkor állítható, ha az Exposure Mode beállítás nem Customize és nem 
is Manual értékű, és a Image Stabilizer funkció le van tiltva. 

WDR Level 

A WDR funkció engedélyezését követően a WDR-szint állításával javíthat a képminőségen. 

Megjegyzés:  
Állítson be 7-es vagy magasabb szintet, ha erős kontraszt van a helyszín fényviszonyainál 
tapasztalható világos és sötét között. Alacsony kontraszt esetén javasolt a WDR funkciót 
letiltani vagy 1 és 6 közötti értéket beállítani. 

Suppress WDR 
Stripes 

Ha engedélyezve van, a kamera a képeken megjelenő csíkozódások minimalizálása 
érdekében automatikusan a megvilágítás frekvenciájához tudja igazítani a lassú 
zárfrekvenciát. 

 

3. Az alapértelmezett beállítások visszaállításához kattintson a Default lehetőségre. 

Intelligens megvilágítás 

 MEGJEGYZÉS! 
Ez a funkció típusonként eltérő lehet. A részletekért lásd a tényleges webes felületet.  

 

1. Kattintson a Setup > Image > Image elemre, majd a Smart Illumination lehetőségre. 
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2. Itt választhatja ki a megfelelő IR-vezérlési módot és állíthatja be a paramétereket. A következő 
táblázat néhány bőbb paramétert mutat be. 

Paraméter  Leírás  

Lighting Type 

 Infravörös: A kamera infravörös megvilágítást használ. 
 Fehér fény: A kamera fehér fényű megvilágítást használ. 

Megjegyzés: 
Ha a Control Mode beállítása Manual, a kamera 0 és 1000 közötti megvilágítási szintet tud 
beállítani. 

Control Mode 

 Globális mód: A kamera úgy állítja be az IR megvilágítást és expozíciót, hogy 
kiegyensúlyozott képhatást érjen el. Ha ezt az opciót választja, akkor egyes területek 
túlexponáltak lehetnek. Ez az opció akkor javasolt, ha a megfigyelt terület és a kép 
fényereje az elsődleges prioritás. 

 Túlvezérlési korlát: A kamera úgy állítja be az IR megvilágítást és expozíciót, hogy 
elkerülje a helyi túlexponálást. Ha azt ez opciót választja, akkor egyes területek sötétek 
lehetnek. Ez az opció akkor javasolt, ha a kép középső részének tisztasága és a 
túlexponálás kézben tartása az elsődleges prioritás. 

 Út: Ez az üzemmód összességében erőteljes megvilágítást kínál, és széles 
paramétertartományú helyszíneken, például utak esetén javasolt. 

 Park: Ez az üzemmód egyenletes fényviszonyokat kínál, és szűk paramétertartományú, 
számos akadállyal rendelkező helyszíneken, például ipari parkokban javasolt. 

 Kézi: Ebben az üzemmódban manuálisan szabályozhatja az IR megvilágítás intenzitását. 
 Beltéri: Ez az üzemmód beltéri helyszíneken történő alkalmazás esetén javasolt. 

Illumination 
Level 

Az IR fény intenzitásának szintjét állítja be. A magasabb érték nagyobb intenzitást jelent. 
A 0 kikapcsolt IR megvilágítást jelent. 

 Közeli megvilágítási szint: Széles látószögű helyszíneket először ennek a paraméternek a 
beállítása javasolt. 

 Közepes megvilágítási szint: Először ennek a paraméternek a beállítása javasolt, ha a 
helyszín közepes fókusztávolságot igényel. 

 Távoli megvilágítási szint: Ha a helyszínhez teleobjektív beállítású nézet szükséges, 
akkor először ennek a paraméternek a beállítása javasolt. 

Megjegyzés: 
Ez a paraméter csak akkor állítható, ha a Control Mode beállítása Manual. 

 

3. Az alapértelmezett beállítások visszaállításához kattintson a Default lehetőségre. 

Élességbeállítás  

 MEGJEGYZÉS! 
Ez a funkció típusonként eltérő lehet. Részletekért lásd a tényleges típusokat.  

 

1. Kattintson a Setup > Image > Image elemre, majd a Focus lehetőségre. 
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2. Válassza ki a kívánt élességállítási módot. 

Paraméter Leírás 

Focus Mode 

 Automatikus élességállítás: A kamera az aktuális fényviszonyoknak megfelelően, 
automatikusan állítja be az élességet. 

 Kézi élességállítás: A kamera élességét kézzel kell beállítani. 
 Egykattintásos élességállítás: A kamera elforgatáskor, zoomoláskor vagy presetre 

ugráskor állít élességet. 
 Egykattintásos élességállítás (IR): Ez az élességállítási mód gyenge fényviszonyok mellett, 

például éjszaka vagy sötét épületen belül jobb hatást biztosít bekapcsolt IR megvilágítás 
használata esetén. 

Scene 

 Normál: Általános helyszíneken, például utakon vagy ipari parkokban használatos. 
 Nagy távolság: Úton végzett, nagy távolságú térfigyelés esetén használatos. Amikor 

például a kamera 30 méter magasan van felszerelve egy távoli közlekedési csomópont 
figyeléséhez. 

 

3. Az alapértelmezett beállítások visszaállításához kattintson a Default lehetőségre. 

Fehéregyensúly 
A fehéregyensúly a különböző színhőmérsékletű képek természetellenes színeinek eltolása annak 
érdekében, hogy az így keletkező kép az emberi szem számára a legmegfelelőbb legyen. 

 MEGJEGYZÉS! 
Ez a funkció típusonként eltérő lehet. A részletekért lásd a tényleges webes felületet. 

 

1. Kattintson a Setup > Image > Image elemre, majd a White Balance lehetőségre. 

 
2. Válassza ki a kívánt fehéregyensúly módot. A következő táblázat néhány bőbb paramétert mutat be. 
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Paraméter Leírás 

White Balance 

Itt állíthat a kép vörös vagy kék szín eltolódási értékén: 

 Auto/Auto2: A kamera a fényviszonyoknak megfelelően, automatikusan állítja be a 
vörös- és kékeltolást (a színek kékes árnyalat felé hajlanak). Ha a képek Auto módban 
továbbra is természetellenesen vörös vagy kék árnyalatúak, akkor próbálja meg az 
Auto2 beállítást. 

 Finomhangolás: Lehetővé teszi a vörös- és kékeltolás kézi beállítását. 
 Kültéri: Viszonylag magas színhőmérsékletű, kültéri környezetben használható. 
 Zárolt: Módosítás nélkül zárolja az aktuális színhőmérsékletet. 
 Nátriumlámpa: A kamera a fényviszonyoknak megfelelően, automatikusan állítja be a 

vörös- és kékeltolást (a színek vöröses árnyalat felé hajlanak). 

Red Offset 
Itt állíthatja be a vörös eltolódását manuálisan. 

Megjegyzés:  
Ez a paraméter csak akkor állítható, ha a White Balance beállítása Fine Tune. 

Blue Offset 
Itt állíthatja be a kék eltolódását manuálisan. 

Megjegyzés: 
Ez a paraméter csak akkor állítható, ha a White Balance beállítása Fine Tune. 

 

3. Az alapértelmezett beállítások visszaállításához kattintson a Default lehetőségre. 

Speciális 

A párátlanítás funkcióval állíthatja be a ködös, párás viszonyok között rögzített képek tisztaságát. 

1. Kattintson a Setup > Image > Image elemre, majd az Advanced lehetőségre. 

 

 MEGJEGYZÉS! 
 Ez a paraméter csak kikapcsolt WDR funkció mellett állítható. 
 Az optikai páramentesítés funkciót csak bizonyos kameratípusok támogatják. Ha a Defog beállítása 

On, akkor a párátlanítás intenzitásának 6 és 9 közötti szintje optikai páramentesítést jelent, és a
szint 5-ről 6-ra váltásakor a kép színesről fekete-fehérre vált. Ha a Defog beállítása Auto és a 
párátlanítás szintje 6 és 9 között van, akkor a képek enyhe páraviszonyok esetén nem váltanak
automatikusan fekete-fehérre, a kamera erős köd esetén vált optikai páramentesítésre. 

 

2. Engedélyezze a párátlanítás funkciót, majd válasszon egy szintet a helyszínhez. A 9. szint jelenti a 
maximális párátlanítási hatást, míg az 1. a minimumot jelenti. 

  
Párátlanítás ki Párátlanítás be 
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3. Az alapértelmezett beállítások visszaállításához kattintson a Default lehetőségre. 

Világítás típusa 

 MEGJEGYZÉS! 
Ez a funkció típusonként eltérő lehet. Részletekért lásd a tényleges típust.  

 

1. Válassza a Setup > Image > Image lehetőséget, majd kattintson a Smart Illumination elemre 

 

2. Válasszon egy opciót a Lighting Type legördülő listából. 

3. Az alapértelmezett beállítások visszaállításához kattintson a Default lehetőségre. 

A rekesz és optikamód beállítása 

 MEGJEGYZÉS! 
 Ezt a funkciót csak bizonyos típusú hálózati box kamerák támogatják. Részletekért lásd a tényleges

típust. 
 Használja az objektívet P-Iris vezérlési módban, és csatlakoztassa a rekeszvezérlő kábelt a kamera

Z/F-csatlakozójához. 
 A rekesz csak akkor állítható, ha a Lens Mode beállítása P-IRIS. 

 

1. Kattintson a Setup > Image > Image elemre, majd az Advanced lehetőségre. 

 

2. Szükség szerint módosítsa a beállításokat. A következő táblázat néhány bőbb paramétert mutat be. 

Paraméter Leírás 

Lens Mode 
 Z/F: az élesség és zoom módosításához. 
 P-Iris: a rekeszérték módosításához. 

Aperture 
Control 

A rekesz automatikus vagy kézi állítása. 
Megjegyzés:  
Ez a paraméter csak akkor állítható, ha a Lens Mode beállítása P-Iris. 

F-Number A rekesz kézi állítása. 

 

3. Az alapértelmezett beállítások visszaállításához kattintson a Default lehetőségre. 

Az OSD-menü beállítása 

A képernyőmenü (OSD) a videoképekkel együtt a képernyőn megjelenő szöveg, amely az időt, illetve egyéb, 
egyedileg beállított elemeket tartalmazhat. 

 MEGJEGYZÉS! 
Ez a funkció típusonként eltérő lehet. A részletekért lásd a tényleges webes felületet. 
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1. Kattintson a Setup > Image > OSD elemre. 

 

Egyes modellek OSD-felülete az alábbi módon néz ki. 

  

2. Válassza ki az OSD-menü pozícióját és tartalmát. 

 Pozíció: Kattintson a kívánt mezőre a Live View területen. A kurzor formájának megváltozását 
követően kattintson a gombra, és tartsa nyomva a szövegmező kívánt pozícióba mozgatásához.  
A pozíció pontos beállításához használja a Overlay Area alatti X és Y koordinátákat. 

 Overlay OSD Content: A legördülő listában adhatja meg a Time, Preset és Serial Info adatokat. 
Emellett választhatja a Custom lehetőséget, ahol megadhatja a kívánt tartalmat. 

 Az OSD-tartalom pozíciójának beállítását követően a Status oszlopban megjelenik az OSD sikeres 
beállítását jelző  szimbólum. Az egyes területekhez több sornyi tartalmaz is beállíthat, majd a  és 

 gombokkal állíthatja be a megjelenítés sorrendjét. 

3. A beállítások elvégzését követően megjelenik egy sikeres beállítást jelző üzenet. 

Az előnézetablakra jobb egérgombbal kattintva, teljes képernyős módban vagy adott képaránnyal láthatja a 
képet. Továbbá, az előnézetablakra duplán kattintva léphet teljes képernyős módba, illetve léphet ki belőle. 

Egy területhez beállított OSD törléséhez törölje az OSD-tartalmat az Overlay OSD Content oszlopban, vagy a 
Position oszlopban válassza a None lehetőséget. 
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Az alábbiakban egy példaként beállított időt megjelenítő OSD látható. 

 

Adatvédelmi maszk 

Bizonyos esetekben előfordulhat, hogy a személyes adatok védelme érdekében egy maszkolt területet kell 
a kamerán beállítani, például egy bankautomata billentyűzeténél. A PTZ pozíciójának vagy zoomjának 
változásakor az adatvédelmi maszk végig megfelelően módosul, hogy biztosítsa a kívánt terület védelmét. 

 MEGJEGYZÉS! 
Ez a funkció típusonként eltérő lehet. A részletekért lásd a tényleges webes felületet.  

 

1. Kattintson a Setup > Image > Privacy Mask elemre. 

 
Egyes kameratípusok esetén az oldal az alábbiaknak megfelelően jelenik meg: 
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2. A  gombra kattintva adhat hozzá adatvédelmi maszkot, egy maszk törléséhez pedig kattintson a  
gombra. 

 Egy adott pozíció maszkolása: Kattintson a dobozra (a maszk helyén) a maszk aktiválásához. A kurzor 
formájának megváltozását követően húzza a dobozt a kívánt helyre. 

 Egy terület maszkolása: Rajzoljon az egérrel egy téglalapot a maszkolni kívánt területre. 

Az adatvédelmi maszk beállítását követően a kívánt terület takarva van. Az alábbiakban egy példát láthat. 

 

Hang- és videobeállítások 

Videobeállítások 

Beállíthatja a kamera által támogatott videoparamétereket, és megtekintheti a BNC-kimeneten adott 
aktuális állapotot. Ha elérhető, igény szerint engedélyezheti a második, illetve harmadik adatfolyamot is. 

 MEGJEGYZÉS! 
 Ez a funkció típusonként eltérő lehet. A harmadik adatfolyamot csak bizonyos kameratípusok támogatják.

A webes felületen tudja megállapítani, hogy kamerája támogatja-e ezt a funkciót. 
 A második vagy harmadik adatfolyam engedélyezését követően szükség szerint végezze el a paraméterek

módosítását. A második és harmadik adatfolyam paramétereinek funkciója a fő adatfolyaméval
megegyező. 
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1. Kattintson a Setup > Video & Audio > Video elemre. 

 

2. Szükség szerint módosítsa a beállításokat. A következő táblázat néhány bőbb paramétert mutat be. 

Paraméter Leírás 

Video 
Compression 

Háromféle beállítás: H.265, H.264 és MJPEG. 
Megjegyzés: 

 Ha a beállított videotömörítés H.265 vagy H.264, akkor a képminőség nem állítható. 
MJPEG beállítása esetén csak háromféle képfrissítési frekvencia érhető el: 1, 3 és 5, 
továbbá a bitsebesség, az I-frame intervallum, a simítás és az U-kód nem állítható. 

 A beállítás H.264 értékről H.265 értékre váltásakor a bitsebesség az alapértelmezett 
értékre áll vissza. A H.265 alapértelmezett bitsebessége a H.264 fele. 

Frame Rate 

A képek kódolásakor alkalmazott képfrissítési frekvencia. Mértékegység: FPS (képkockák 
száma másodpercenként). 

Megjegyzés: 
A képminőség biztosítása érdekében ügyeljen arra, hogy a képfrissítési frekvencia ne 
legyen nagyobb a zársebességnél. 

Bitrate Type 

 CBR: Állandó bitsebesség, ami azt jelenti, hogy a kamera állandó adatátviteli 
sebességgel küldi az adatokat. 

 VBR: Változó bitsebesség, ami azt jelenti, hogy a kamera a képminőségnek 
megfelelően,dinamikusan állítja a bitsebességet. 

Image Quality 

Ha az Encoding Mode beállítása VBR, akkor a csúszka mozgatásával beállíthatja a 
képminőség szintjét. A csúszkát a Bit Rate irányába mozgatva a bitsebesség csökken, ami 
ronthatja a képminőséget. A csúszka Quality irányába történő mozgatása növeli a 
bitsebességet, emellett javítja a kép minőségét. 

I Frame Interval Az I-frame kódolási időintervalluma. A rövidebb I-frame intervallum normál esetben jobb 
képminőséget eredményez, azonban nagyobb sávszélességet igényel. 

GOP Képcsoport az MPEG videokódolásban. Ez a paraméter határozza meg az intra-frames 
(I-frame) és inter-frame képkockák kódolási sorrendjét. 
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Paraméter Leírás 

SVC Az SVC (skálázható videokódolás) képes a tárhelyigényt a lejátszási minőség romlása 
nélkül csökkenteni. 

U-Code 

 Alapmód: A tényleges bitsebesség a beállított bitsebesség körülbelül 3/4-e. 
 Speciális mód: A tényleges bitsebesség a beállított bitsebesség körülbelül 1/2-e. 

Megjegyzés: 
 Az U-kód engedélyezése esetén a videotömörítés csak a H.264 és H.265 szabványokat 

támogatja. Az MJPEG nem támogatott. 
 Az U-kód engedélyezése esetén a rögzítési mód nem támogat 30-nál nagyobb 

képfrissítési frekvenciát. 

Smoothing 

A simítás mértékét állítja be. A Clear opció kiválasztása a Smoothing funkció letiltását 
jelenti. A csúszkát a Smooth irányába mozgatva növelheti a simítás mértékét, ezzel 
azonban rontja a képminőséget. 

Megjegyzés:  
Gyenge hálózati környezetben a simítás engedélyezésével folyamatosabb videoképet 
érhet el. 

BNC Output A BNC-kimenet az NTSC és PAL szabványokat támogatja. 

 

3. Kattintson a Save lehetőségre. 

Hangbeállítások 

A hangbeállítások a kamera hangkódolási paramétereinek beállítását jelenti. 

 MEGJEGYZÉS! 
Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típust. 

 

1. Kattintson a Setup > Video & Audio > Audio elemre. 

 
2. Szükség szerint módosítsa a beállításokat. A következő táblázat néhány bőbb paramétert mutat be. 

Paraméter Leírás 

Audio Input 

Az Off lehetőség kiválasztása esetén a kamera nem végez hangkódolást. 

Megjegyzés:  
Amennyiben nincs szükséges hangra, javasoljuk az Off lehetőség választását. Ezzel bizonyos 
mértékig javíthatja az eszköz teljesítményét. 
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Paraméter Leírás 

Access Mode 

Jelenleg csak a Line/Mic beállítás érhető el. 

Megjegyzés:  
Ez a funkció két hangcsatornával ellátott eszközökön nem érhető el. 

Audio 
Compression 

Háromféle beállítás: G.711U, G.711A és ACC-LC.  

A G.711U és G.711A szabványok csak a 8K mintavételi frekvenciát támogatják, míg az 
ACC-LC az 8K, 16K és 48K mintavételi frekvenciát is támogatja. 

Input Gain Audiojel-erősítés a mintavételezéshez. A nagyobb gain érték nagyobb erősítést jelent. 

Noise 
Suppression 

Képek melletti zaj csökkentésére szolgál. A zajcsökkentés engedélyezéséhez válassza az On 
lehetőséget. 

Channel 

Kimeneti hangcsatorna. A hangkimenet engedélyezéséhez válassza az Enable beállítást. 

Megjegyzés:  

A két hangcsatornát csak bizonyos kameratípusok támogatják. 

 

3. Kattintson a Save lehetőségre. 

Pillanatfelvétel 

1. Kattintson a Setup > Video & Audio > Snapshot elemre. 

 
2. Válassza az On lehetőséget, majd igény szerint állítsa be a felbontást, a képminőséget és az ütemezést. 

3. Kattintson a Save lehetőségre. 

ROI 

Ha az Érdekeltségi tartomány (ROI) funkció engedélyezve van, akkor a rendszer a ROI területen belüli 
képminőségnek biztosít elsőbbséget, amennyiben az elérhető bitsebesség nem lenne elegendő. 

 MEGJEGYZÉS! 
Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típust. 

 

1. Kattintson a Setup > Video & Audio > ROI lehetőségre. 
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2. Kattintson a  gombra, majd húzza el az egeret a kívánt képrészek fölött. A törléshez válassza ki a 

területet, majd kattintson a  gombra. 

Adatfolyam-beállítások 

Adatfolyam 
Megjeleníthet egy kamera felől létrejött adatfolyamot. Emellett beállíthatja a kamerát, hogy egy megadott 
IP-címre és portszámra UDP vagy TCP protokoll szerint kódolt adatfolyamot küldjön. A beállítások 
menthetők, és ezek a kamera újraindítását követően jutnak érvényre. 

 MEGJEGYZÉS! 
 Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típust. 
 Az adatátviteli protokollt a tényleges igényeknek és a hálózat teljesítményének megfelelően kell 

megválasztani. Általánosan véve, a TCP jobb képminőséget biztosít, mint az UDP, de nagyobb 
késleltetést is okoz. 

 

1. Kattintson a Setup > Video & Audio > Media Stream lehetőségre. 

 

2. Kattintson a  gombra, válasszon egy adatfolyamtípust, majd válassza ki a hang- és 

video-adatfolyamot fogadó eszköz unicast vagy multicast csoportjának IP-címét és portszámát. 
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Ha azt szeretné, hogy az eszköz az újraindítást követően automatikusan létrehozza az előzőleg 
beállított adatfolyamot, akkor a Persistent beállításnál válassza a Yes opciót. 

3. Egy adatfolyam törléséhez kattintson a  gombra. 
4. A művelet végrehajtásához kattintson a Submit elemre. 

RTSP Multicast cím  
Egy RTSP Multicast cím beállítását követően a külső lejátszó RTP protokollon keresztül tudja kérni az RTSP 
Multicast adatfolyamot a kamerától. 

1. Kattintson a Setup > Video & Audio > Media Stream > RTSP Multicast Address lehetőségre. 

 
Egyes kameratípusok esetén az oldal az alábbiaknak megfelelően néz ki. 
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2. Állítsa be a Multicast címet (224.0.0.0 – 239.255.255.255) és a portszámot (0 – 65535). 

3. Kattintson a Save lehetőségre. 

Intelligens riasztás beállítása 
Az intelligens felügyelet beállításával személyszámlálást végezhet, illetve figyelheti a mozgó objektumokat. 
Az intelligens felügyelet többek között a személyszámlálást, behatolásérzékelést, valamint az automatikus 
követést foglalja magába. 

A támogatott funkciók kameratípusonként változhatnak. 

Smart beállítások 

Kattintson a Setup > Intelligent > Smart Settings lehetőségre. 

 
Egyes kameratípusok esetén az oldal az alábbiaknak megfelelően néz ki. 

 

Vonalátlépés-érzékelés 

A vonalátlépés-érzékelés az élő videoképen egy virtuális vonalat átlépő objektumokat érzékel, és ennek 
bekövetkezésekor riasztást generál. 
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1. Kattintson a Setup > Intelligent > Smart Settings lehetőségre. Jelölje be a Cross Line jelölőnégyzetet, 

majd kattintson a  gombra. 

 

 

2. Jelölje be a Cross Line Detection opciót. 

3. A Detection Rule részben kattintson a  gombra, majd adjon hozzá egy új érzékelési területet. Egy 

érzékelési terület törléséhez kattintson a  gombra. 
4. A kis előnézetablakban húzza a vonalat a kívánt pozícióba, majd állítsa be az érzékelési hatótávolságot. 

5. Állítsa be az irányt és az érzékenységet, amely alapján a kamera eldöntheti, hogy kezdeményezzen-e 
vonalátlépés-riasztást. 

6. Szükség szerint állítsa be a riasztás által indított műveleteket és az élesítés ütemezését. A részletes 
lépésekkel kapcsolatban lásd A mozgásérzékelési riasztás beállítása című fejezetben szereplő, riasztás 
által elindított műveleteket. 

7. Kattintson a Save lehetőségre. 

Behatolásérzékelés 

A behatolásérzékelés az élő videokép egy meghatározott területére belépő objektumokat érzékeli, és ennek 
bekövetkezésekor riasztást generál. 

1. Kattintson a Setup > Intelligent > Smart Settings lehetőségre. Jelölje be a Intrusion jelölőnégyzetet, 

majd kattintson a  gombra. 
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2. Jelölje be az Intrusion Detection jelölőnégyzetet. 

3. A Detection Rule részben kattintson a  gombra, majd adjon hozzá egy új érzékelési területet. Egy 

érzékelési terület törléséhez kattintson a  gombra. 
4. Húzza a téglalap oldalait a kívánt pozíció és hatótávolság beállításához. 

5. Állítsa be az időküszöböt, az érzékenységet és a százalékértéket, amely alapján a kamera eldöntheti, 
hogy kezdeményezzen-e behatolásérzékelési riasztást. 

 Time Threshold: Az a minimális idő, amennyit a behatolónak az érzékelési területen kell töltenie, 
mielőtt a rendszer riasztást kezdeményez. 

 Sensitivity: Az érzékelés érzékenysége. A magasabb érték nagyobb érzékelési érzékenységet jelent. 

 Percentage: A behatoló méretének a megadott érzékelési terület méretéhez viszonyított, a riasztás 
kezdeményezéséhez szükséges minimális aránya. 

6. Szükség szerint állítsa be a riasztás által indított műveleteket és az élesítés ütemezését. A részletes 
lépésekkel kapcsolatban lásd A mozgásérzékelési riasztás beállítása című fejezetben szereplő, riasztás 
által elindított műveleteket. 

7. Kattintson a Save lehetőségre. 

Arcérzékelés 

Az arcérzékelés emberi arcokat érzékel az élő videoképben. 

1. Kattintson a Setup > Intelligent > Smart Settings lehetőségre. Válassza a Face lehetőséget, majd 

kattintson a  gombra. 
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2. Húzza a szegélyvonalakat a kívánt pozíció és hatótávolság beállításához. 

3. Állítsa be az érzékelési paramétereket a tényleges igényeknek megfelelően. 

4. Szükség szerint állítsa be a riasztás által indított műveleteket és az élesítés ütemezését. A részletes 
lépésekkel kapcsolatban lásd A mozgásérzékelési riasztás beállítása című fejezetben szereplő, riasztás 
által elindított műveleteket. 

5. Kattintson a Save lehetőségre. 

6. Kattintson a Start Intelligent Analysis gombra. 

Személyszámlálás 

 MEGJEGYZÉS! 
 Ezt a funkciót csak néhány kameratípus támogatja. 
 A támogatott riasztáskezdeményezési és riasztási ütemezés kameratípustól függően változhat. 

A részletekért lásd a tényleges webes felületet. 

 

1. Kattintson a Setup > Intelligent > Smart Settings lehetőségre. Válassza a People Counting elemet, 

majd kattintson a  gombra. 
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2. Jelölje be az Enable Passenger Flow Detection jelölőnégyzetet. Válasszon ki egy érzékelési módot, és 

állítsa be a jelentési intervallumot, valamint az érzékenységet. 

3. Kattintson a Draw Detection Area lehetőségre, majd a bal oldali előnézetablakban rajzoljon egy 
érzékelési területet, például egy négyzetet. 

4. Kattintson a Draw Entrance Direction elemre, majd a bal oldali előnézetablakban rajzolja be az irányt. 
Az irány általában függőleges vagy ferde. 

5. Állítsa be a Filter by Object Size alatti Max. Size és Min. Size értékeket. A rendszer csak a 
mérettartományba eső objektumokat számolja, a többit kiszűri a számolásból. 

6. Szükség szerint állítsa be a riasztás által indított műveleteket és az élesítés ütemezését. A részletes 
lépésekkel kapcsolatban lásd A mozgásérzékelési riasztás beállítása című fejezetben szereplő, riasztás 
által elindított műveleteket. 

7. A számlálási eredmény nullázásához kattintson a Clear Counting Result elemre. 

8. Kattintson a Save lehetőségre. 

Automatikus követés 

A kamera automatikusan követi a szabályt elindító objektumot. 

 MEGJEGYZÉS! 
 Ezt a funkciót csak néhány kameratípus támogatja. 
 A támogatott riasztáskezdeményezési és riasztási ütemezés kameratípustól függően változhat. 

A részletekért lásd a tényleges webes felületet. 

 

1. Kattintson a Setup > Intelligent > Smart Settings lehetőségre. Válassza az Auto Tracking lehetőséget, 

majd kattintson a  gombra. 
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2. Állítsa be a követési időkorlátot (másodpercben) és a zoomarányt. 

3. Kattintson a Save lehetőségre. 

Élesség-elállítódás érzékelése 

 MEGJEGYZÉS! 
 Ezt a funkciót csak néhány kameratípus támogatja. 
 A támogatott riasztáskezdeményezési és riasztási ütemezés kameratípustól függően változhat. 

A részletekért lásd a tényleges webes felületet. 

 

Az élesség-elállítódás érzékelése funkcióval észlelheti, ha a kamera élessége elállítódott, és ilyen esetben 
riasztást kezdeményezhet. 

1. Kattintson a Setup > Intelligent > Smart Settings lehetőségre. Válassza a Defocus lehetőséget, majd 

kattintson a  gombra. 

 

2. Jelölje be a Defocus Detection jelölőnégyzetet. 

3. Szükség szerint állítsa be az érzékelés érzékenységét és a riasztás által indítandó műveleteket. A 
részletes lépésekkel kapcsolatban lásd A mozgásérzékelési riasztás beállítása című fejezetben szereplő, 
riasztás által elindított műveleteket. 

4. Kattintson a Save lehetőségre. 
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Helyszínváltozás érzékelése 

 MEGJEGYZÉS! 
 Ezt a funkciót csak néhány kameratípus támogatja. 
 A támogatott riasztáskezdeményezési és riasztási ütemezés kameratípustól függően változhat. 

A részletekért lásd a tényleges webes felületet. 

 

A helyszínváltozás-riasztás segítségével észlelheti a térfigyelési környezet külső tényezők, például a kamera 
elfordulása általi változását, és ilyen esetben riasztást kezdeményezhet. 

1. Kattintson a Setup > Intelligent > Smart Settings lehetőségre. Válassza a Scene Change lehetőséget, 

majd kattintson a  gombra. 

 
2. Jelölje be a Scene Change Detection jelölőnégyzetet. 

3. Állítsa be az érzékelés érzékenységét. Szükség szerint állítsa be a riasztás által indított műveleteket és 
az élesítés ütemezését. A részletes lépésekkel kapcsolatban lásd A mozgásérzékelési riasztás beállítása 
című fejezetben szereplő, riasztás által elindított műveleteket. 

4. Kattintson a Save lehetőségre. 

Speciális beállítások 

A speciális beállítások közé tartozik a pillanatfelvétel képtisztasága és az intelligens funkciók érzékelési 
módja. 

Fotó paraméterei 

A pillanatfelvétel képtisztaságát állítja be. 

1. Kattintson a Setup > Intelligent > Advanced Settings elemre. Kattintson a Photo parameters fülre. 
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2. Állítsa be az eredeti kép és a miniatűr képtisztaságát. 

3. Kattintson a Save lehetőségre. 

 MEGJEGYZÉS! 
A fotó paramétereinek állítása előtt kapcsolja ki az arcérzékelés funkciót. 

 

Érzékelési paraméterek 

 MEGJEGYZÉS! 
 A speciális beállításokat csak bizonyos kameratípusok támogatják. A részletekért lásd a tényleges 

webes felületet. 
 Az alapértelmezett érzékelési mód a Normal Mode. Igény szerint állítsa be. 

 

1. Kattintson a Setup > Intelligent > Advanced Settings elemre. Kattintson a Detection parameters fülre. 

 

2. Válasszon egy érzékelési módot. A térfigyelési környezetben érzékelt ismétlődő mozgás általi 
ismétlődő riasztás elkerüléséhez jelölje be a Filter Repeated Motion Mode jelölőnégyzetet. 

3. Kattintson a Save lehetőségre. 

Általános riasztási beállítások 
Ütemezheti a riasztások kezdeményezését, és más eszközök által indítható műveleteket állíthat be, így a 
riasztásokat és az indított műveleteket idő szerint kézben tarthatja. 

A riasztás kezdeményezése a mozgásérzékelési riasztáshoz, a riasztási bemenethez, riasztási kimenethez, a 
szabotázsriasztáshoz, valamint a hangérzékelési riasztáshoz ütemezhető. A támogatott riasztások 
eszköztípustól függően eltérőek. A kamera által támogatott riasztási típusokkal kapcsolatban lásd a webes 
felületet. 

A mozgásérzékelési riasztás beállítása 

A mozgásérzékelés funkció egy objektum meghatározott téglalap alakú területen belüli, megadott 
időintervallumban történő mozgását érzékeli. Egy mozgásérzékeléskor kezdeményezett riasztáshoz be kell 
állítania az érzékelési területet, az érzékelés érzékenységét, az objektum méretét, valamint a kamerához 
kapcsolódó előzményeket annak eldöntésére, hogy a kamera kezdeményezzen-e mozgásérzékelési riasztást. 

 MEGJEGYZÉS! 
 Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típust. 
 A riasztás által indított műveletek típusonként eltérőek. A részletekért lásd a tényleges webes felületet. 
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Adott terület érzékelése 
1. Kattintson a Setup > Events > Common Alarm > Motion Detection lehetőségre. A Detection Mode 

beállításnál válassza az Area opciót. 

 

2. A Detection Area területen a  gombra kattintva adhat hozzá új érzékelési területet. Egy érzékelési 

terület törléséhez kattintson a  gombra. 
3. Egérkattintással és áthúzással állítsa be az érzékelési területet. 

4. Állítsa be az érzékelés érzékenységét, az objektum méretét, valamint a kamerához kapcsolódó 
előzményeket annak eldöntésére, hogy a kamera kezdeményezzen-e mozgásérzékelési riasztást. 

 A csúszkát jobbra mozgatva növelheti az érzékelés érzékenységét. Ha az érzékelési területen belüli 
mozgás mértéke meghaladja a beállított objektumméretet, valamint ha a mozgás időtartama 
meghaladja a beállított időtartamot, a kamera riasztást kezdeményez. 

 Az objektum mérete határozza meg az objektumméretnek azt az érzékelési terület méretéhez 
viszonyított minimális arányát, amelynél a kamera riasztást kezdeményez. Ennek megfelelően kis 
méretű tárgyak mozgásának érzékeléséhez egy kis téglalapot (érzékelési területet) kell rajzolnia a 
tényleges mozgási területen belül. 

 A mozgásérzékelés eredménye valós időben jelenik meg. A piros vonalak az indított mozgásérzékelési 
riasztásokat jelzik. A hosszabb vonalak nagyobb mértékű mozgást jeleznek. A sűrűbb vonalak nagyobb 
mozgási gyakoriságot jeleznek. 

 
 

5. Állítsa be a riasztási paramétereket. 

 Riasztás(ok) elnyomása: Egy riasztás kezdeményezését követően a kamera a beállított időtartamig 
nem kezdeményezi ugyanazt a riasztást. 
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 Riasztás(ok) törlése: Egy riasztás kezdeményezését követően, 

a. Ha ugyanaz a riasztás egy beállított időn belül nem fordul elő újra, akkor a riasztás törlődik, és a 
kérdéses riasztási ismét kezdeményezhető. 

b. Ha ugyanaz a riasztás a beállított időn belül újra előfordul, akkor a riasztás mindaddig nem lesz 
törölve, amíg a riasztáselnyomási idő le nem telik. Ezután ugyanaz a riasztás ismét 
kezdeményezhető. 

6. Állítsa be a mozgásérzékelési riasztás által indított műveleteket és az időtervet. 

 

Az alábbi táblázat a riasztás által kezdeményezhető főbb műveleteket, valamint az időterv beállításának 
módját mutatja be. 

Tétel Leírás 

Alarm 
Output 1 

Jelölje be a jelölőnégyzetet. Ez a beállítás a mozgásérzékelési riasztáshoz kapcsolódó riasztási 
kimenetre vonatkozik. 

Megjegyzés:  
Egy riasztás kezdeményezésekor a kamera egy külső eszköz általi művelet indítása érdekében 
aktiválja a riasztási kimenetet. 

Goto 
Preset 

Jelölje be a jelölőnégyzetet, majd állítsa be a mozgásérzékelési riasztáshoz kapcsolódó presetet. 

Megjegyzés: 
 Ellenőrizze, hogy vannak-e beállított presetek. Ellenkező esetben ez a paraméter nem 

állítható. Egy preset beállításának részleteire vonatkozóan lásd: Presetek beállítása. 
 Riasztás kezdeményezésekor a PTZ kamera automatikusan a megfelelő presetre vált annak 

érdekében, hogy a video rögzítése a megfelelő helyszínbeállítással történjen. 

Upload to 
FTP 

Az Upload to FTP bejelölése esetén riasztás indításakor a kamera automatikusan feltölti a 
pillanatfelvételeket a megadott FTP-kiszolgálóra. 

Megjegyzés: 
A funkció használata előtt ellenőrizze, hogy megadta-e az FTP és Pillanatfelvétel beállításokat. 

Recording 

A Recording bejelölése esetén riasztáskor a kamera automatikusan rögzíti a videót. 

Megjegyzés: 

Ehhez először a Storage oldalon adja meg a Post-Record(s) beállítás(oka)t. A Post-Record(s) 
beállítás határozza meg, hogy a felvétel a riasztás megszűnését követően mennyi időn keresztül 
folytatódjon. 

Alarm the 
Center 

Ha az Alarm the Center be van jelölve, akkor riasztáskor a kamera elküldi a riasztási 
információkat a központi szerver felé. 

Megjegyzés: 

Ehhez először végezze el a beállításokat a Server oldalon. 

Trigger 
Tracking 

Ha a Trigger Tracking be van jelölve, akkor riasztás esetén a kamera elindítja az automatikus 
követést. 

Megjegyzés: 

Ezt a funkciót csak néhány kameratípus támogatja. 

Először a Smart Settings oldalon állítsa be az automatikus követést. 

Trigger 
E-mail 

A Trigger E-mail bejelölése esetén riasztásakor a kamera automatikusan pillanatfelvételeket küld 
a megadott e-mail címre. 

Megjegyzés: 
A funkció használata előtt ellenőrizze, hogy az E-mail beállítások meg vannak-e adva. 
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Enable Plan 

Jelölje be a jelölőnégyzetet, majd állítsa be a kezdési és befejezési időket, amelyek alatt a 
mozgásérzékelési riasztás aktív. Az időtervet közvetlenül, az egér húzásával is megadhatja, majd 
az Edit elemre kattintva szerkesztheti a táblázatban szereplő időszakokat. Az időszakok nem 
lehetnek átfedésben. A kamera csak a beállított időintervallum(ok)ban kezdeményez riasztást. 

Hétfőtől vasárnapig kiválaszthatja a napot, majd minden egyes naphoz négy időszakot állíthat 
be. 

 

 

Az egeret húzva rajzoljon egy időtervet  Végezze el az időszakok szerkesztését a 
táblázatban 

Megjegyzés:  
Az időterv egérrel történő rajzolása csak az IE böngésző 8.0 utáni verzióiban érhető el. Egy nap 
időtervének beállítását követően a Copy és Paste funkciókkal a többi napra és érvényesítheti 
ugyanazokat a beállításokat. 

 

7. Kattintson a Save lehetőségre. 

Rácsérzékelés 

1. Kattintson a Setup > Events > Motion Detection lehetőségre. A Detection Mode beállításnál válassza a 
Grid opciót. 

 
2. A rácson szabálytalan érzékelési területe(ke)t állíthat be. 

3. Állítsa be a kamera érzékelés érzékenységét annak eldöntésére, hogy a kamera kezdeményezzen-e 
mozgásérzékelési riasztást (a riasztás látható a kompatibilis NVR-eszközökön). 

4. Állítsa be a riasztási paramétereket. 

 Suppress Alarm(s): Egy riasztás kezdeményezését követően a kamera a beállított időtartamig nem 
kezdeményezi ugyanazt a riasztást. 

 Clear Alarm(s): Egy riasztás kezdeményezését követően, 
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a. Ha ugyanaz a riasztás egy beállított időn belül nem fordul elő újra, akkor a riasztás törlődik, és a 
kérdéses riasztási ismét kezdeményezhető. 

b. Ha ugyanaz a riasztás a beállított időn belül újra előfordul, akkor a riasztás mindaddig nem lesz 
törölve, amíg a riasztáselnyomási idő le nem telik. Ezután ugyanaz a riasztás ismét 
kezdeményezhető. 

5. Állítsa be a mozgásérzékelési riasztás által indított műveleteket és az időtervet. A részletes lépésekkel 
kapcsolatban lásd A mozgásérzékelési riasztás beállítása című fejezetben szereplő Adott terület 
érzékelése részt. 

6. Kattintson a Save lehetőségre. 

Szabotázsriasztás beállítása 

A szabotázsriasztást úgy kell beállítani, hogy a kamera riasztást kezdeményezzen, ha az objektívet egy 
bizonyos ideig letakarják. 

 MEGJEGYZÉS! 
 Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típust. 
 A riasztás által indított műveletek típusonként eltérőek. A részletekért lásd a tényleges webes felületet. 

 

1. Kattintson a Setup > Events > Common Alarm >Tampering Alarm lehetőségre. 

 

2. A Tampering Alarm beállításnál válassza az On lehetőséget. 

3. Állítsa be az érzékelés érzékenységét és az időtartamot, amely alapján a kamera eldönti, hogy 
kezdeményez-e riasztást. 

Az érzékenység három szintre van felosztva: magas, közepes és alacsony szint. A közepes szinthez 
képest a magas szint beállítása esetén a kamera képes a távolabbról történő takarást is érzékelni. Ha 
az objektívet egy meghatározott ideig eltakarják, a kamera riasztást generál. 

A szabotázsriasztás az egész képernyőre érvényes. A szabotázsriasztás kikapcsolásához szüntesse meg 
a Tampering Alarm jelölőnégyzet bejelölését. 

4. Állítsa be a szabotázsriasztás által indított műveleteket, valamint az időtervet. A részletes lépésekkel 
kapcsolatban lásd A mozgásérzékelési riasztás beállítása című fejezetben szereplő, riasztás által 
elindított műveleteket. 

5. Kattintson a Save lehetőségre. 
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Hangérzékelési riasztás beállítása 

A kamera képes a bemeneti audiojelekben előforduló kivételeket érzékelni. Ha a hangerő növekedése vagy 
csökkenése eléri a beállított határértéket, vagy ha a bemeneti hangerő elér egy küszöbértéket, a kamera 
riasztást kezdeményez, és elindítja a beállított műveleteket. Győződjön meg arról, hogy megfelelően van 
egy hangeszköz a hangbemenetre csatlakoztatva, és hogy a hangbemenet be van kapcsolva.  
Lásd: A riasztási bemenet beállítása. 

 MEGJEGYZÉS! 
 Ezt a funkciót egyes típusok nem támogatják. A részletekért lásd a tényleges webes felületet. 
 A riasztás által indított műveletek típusonként eltérőek. A részletekért lásd a tényleges webes felületet. 

 

1. Kattintson a Setup > Events > Common Alarm >Audio Detection lehetőségre. 

 
2. Az Audio Detection beállításnál válassza az Enable lehetőséget, válassza ki az érzékelés típusát, majd 

válassza ki az eltérést vagy a küszöbértéket. A hangérzékelés kikapcsolásához szüntesse meg az Enable 
jelölőnégyzet bejelölését. 

A következő táblázat néhány bőbb paramétert mutat be. 

Paraméter Leírás 

Detection 
Type 

 Hirtelen emelkedés: Riasztás kezdeményezése, ha a hangerő növekedése meghaladja a 
beállított eltérést. 

 Hirtelen csökkenés: Riasztás kezdeményezése, ha a hangerő csökkenése meghaladja a 
beállított eltérést. 

 Hirtelen változás: Riasztás kezdeményezése, ha a hangerő növekedése vagy csökkenése 
meghaladja a beállított eltérést. 

 Küszöbérték: Riasztás kezdeményezése, ha a hangerő meghalad egy küszöbértéket. 

Difference 

 Küszöbérték: Egy hangerő küszöbértékként történő beállítását követően a kamera a 
küszöbérték túllépésekor riasztást kezdeményez. 

 Eltérés: két hangerő közötti eltérés. Ha a hangerő növekedése vagy csökkenése 
meghaladja a beállított eltérést, a kamera riasztást kezdeményez. 

Megjegyzés: 
 A hangérzékelési terület léptéke a hangerő mérésére szolgál. 
 A hangérzékelési értékek valós időben jelennek meg. A piros rész a kezdeményezett 

hangérzékelési riasztásokat mutatja. 
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Paraméter Leírás 

 

Difference  

 

3. Szükség szerint állítsa be a riasztás által indított műveleteket és az élesítés ütemezését. A részletes 
lépésekkel kapcsolatban lásd A mozgásérzékelési riasztás beállítása című fejezetben szereplő, riasztás 
által elindított műveleteket. 

4. Kattintson a Save lehetőségre. 

A riasztási bemenet beállítása 

A kamera képes külső eszközről riasztási információkat fogadni. A funkció használatához először a következő 
adatokat kell a riasztási bemenethez beállítani: port, riasztás neve, riasztás típusa (alaphelyzetben nyitott 
vagy alaphelyzetben zárt), valamint a riasztáskezdeményezés típusa. 

 MEGJEGYZÉS!  
 Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típust. 
 A riasztás által indított műveletek típusonként eltérőek. A részletekért lásd a tényleges webes felületet. 

 

1. Kattintson a Setup > Events > Common Alarm > Alarm Input lehetőségre. 

Skála Hangerő 

Eltérés
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2. Válassza ki a riasztást, és adja meg a riasztás nevét. 

3. A riasztási bemenethez csatlakozó külső eszköz típusától függően válassza az N.O. vagy N.C. 
lehetőséget. Ha például a külső eszközhöz tartozó riasztási bemenet beállítása alaphelyzetben nyitott, 
akkor itt válassz az N.O. lehetőséget, hogy a kamera fogadni tudja a riasztási információt a külső 
riasztási eszköz felől. 

4. Állítsa be a riasztási bemenet által indított műveleteket, valamint az időtervet. A részletes lépésekkel 
kapcsolatban lásd A mozgásérzékelési riasztás beállítása című fejezetben szereplő, riasztás által 
elindított műveleteket. 

5. Kattintson a Save lehetőségre. 

A riasztási kimenet beállítása 

A riasztási kimenet mozgásérzékelési riasztás, illetve logikai riasztás általi aktiválását követően a kamera a 
riasztási kimeneten keresztül képes külső eszköz felé riasztási információkat továbbítani, amennyiben a 
riasztási kimenet alaphelyzetben nyitott vagy alaphelyzetben zárt konfigurációja megfelelően van beállítva. 
A riasztási kimenet időtartama beállítható. 

 MEGJEGYZÉS! 
Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típust. 

 

1. Kattintson a Setup > Events > Common Alarm > Alarm Output lehetőségre.  
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2. Válassza ki a riasztást, és adja meg a riasztás nevét. 

3. Állítsa be az állapotot N.O. értékre (alapértelmezett beállítás), majd állítsa be a riasztás időtartamát. 

4. Állítsa be a riasztási bemenet által indított műveleteket, valamint az időtervet. A részletes lépésekkel 
kapcsolatban lásd A mozgásérzékelési riasztás beállítása című fejezetben szereplő, riasztás által 
elindított műveleteket. 

5. Kattintson a Save lehetőségre. 

 
FIGYELEM! 
A kameraalkatrészek károsodásának elkerülése érdekében szigorúan tartsa be az eszközök bekapcsolási
sorrendjét:  
1. Ellenőrizze, hogy a riasztás típusa Alaphelyzetben nyitott (alapértelmezett beállítás) legyen, valamint 

hogy a kamera és a kimeneti eszköz ki legyen kapcsolva.  
2. A csatlakoztatást követően először a kamerát kapcsolja be, majd azt követően a kimeneti eszközt. 

 

Tárolás memóriakártyán 

 MEGJEGYZÉS! 
 Ezt a funkciót egyes típusok nem támogatják, valamint a funkció típusonként eltérő. Részletekért 

lásd a tényleges típust. 
 Ha a kamera önálló módban működik, az edge tároló használata javasolt. Ha a kamera kezelése 

központi kezelő szerveren keresztül történik, akkor az edge tárolót az utólagos gyorsítótáras 
rögzítési szolgáltatás érdekében le kell állítani. 

 

Az edge tároló beállítása 

Az edge tároló segítségével a videoadatok és pillanatfelvételek közvetlenül menthetők a memóriakártyára. 
Az edge tároló használata a kamera önálló módjában javasolt. 
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Kézi tárolás 

Ha a kézi tárolás engedélyezve van,akkor a kamera ismétlődően rögzíti az élő videoképet. 

1. Kattintson a Setup > Storage > Storage lehetőségre. 

 
Egyes kameratípusok esetén az oldal az alábbiaknak megfelelően néz ki. 

 

2. Indítsa el az edge tárolót, majd szükség szerint módosítsa a beállításokat. A következő táblázat néhány 
bőbb paramétert mutat be. 

Paraméter Leírás 

Storage 
Medium 

Tárolási erőforrás típusa. 

Megjegyzés: 
 A memóriakártya formázásához először kapcsolja ki a kártyához kapcsolódó tárolási 

funkciót. Ezután kattintson a Format lehetőségre, majd a művelet megerősítéséhez 
kattintson az OK gombra. A formázás befejeztével a rendszer újraindul. 

 Megjelenik a teljes tárterületre vonatkozó információ. 

Data 
Overwrite 
Policy 

 Felülírás: Ha a memóriakártyán nincs szabad hely, az új adatok ismétlődően felülírják a 
régi adatokat. 

 Leállítás: Ha nincs szabad hely a memóriakártyán, a kamera nem menti az új adatokat a 
memóriakártyára. 

Post-Record(s) Riasztás által indított felvétel esetén a rögzítés a riasztás vége után ennyi ideig folytatódik. 
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3. Kattintson a Save lehetőségre. 

Időterv szerinti tárolás 

Ha az időterv szerinti tárolás engedélyezve van, akkor a kamera a megadott időszakokban rögzíti a videót a 
memóriakártyára. 

1. Kattintson a Setup > Storage > Storage lehetőségre. 

 

Egyes kameratípusok esetén az oldal az alábbiaknak megfelelően néz ki. 
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2. Válassza a Planned Storage lehetőséget, majd állítsa be azokat az időszakokat, ami alatt a kamera a 
videót a videokártyára rögzítse. 

3. Kattintson a Save lehetőségre. 

 MEGJEGYZÉS!  
 Az időterv szerinti tárolás nem használható, ha a kézi tárolás és az időterv szerinti tárolás is

engedélyezve van. 
 A memóriakártyán tárolt felvételek lekérdezésével kapcsolatban lásd: Videó lejátszása és letöltése

az Edge tároló segítségével. 

 

Utólagos gyorsítótáras rögzítés beállítása 

A központilag kezelt kamerák a memóriakártyát a központi szerver tartalék tárolási erőforrásaként tudják 
használni. Ha a kamera jelének központi tárolóeszközön történő tárolása instabil hálózati kapcsolat miatt 
megszakad, akkor a kamera automatikusan elindítja az utólagos gyorsítótáras rögzítést, és a videókat a 
memóriakártyára kezdi menteni. 

Ha a tartalék rögzítés engedélyezve van,akkor a kamera a tartalék szerverrel való kapcsolat helyreállását 
követően képes automatikusan, fájl formájában áttölteni a memóriakártyán tárolt videót a tartalék szerver 
tároló erőforrására. 
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 MEGJEGYZÉS! 
Mielőtt egy kamerán az utólagos gyorsítótáras rögzítés funkciót beállítja, ellenőrizze a következőket: 

 A memóriakártya megfelelően be van helyezve a kamerába. 
 A központi szerver rendelkezik tartalék erőforrással. 
 A tartalék erőforrás a kamera számára van fenntartva. 

 

Az edge tároló kikapcsolása 

1. Kattintson a Setup > Storage > Storage lehetőségre. 

 

Egyes kameratípusok esetén az oldal az alábbiaknak megfelelően néz ki. 

 

2. Az Edge Storage beállításnál válassza a Disable opciót (ami letiltja a kézi tárolás funkciót), és állítsa be 
a videokapacitást. 

3. Kattintson a Save lehetőségre. 
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A rendszer karbantartása 

 MEGJEGYZÉS!  
Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típust. 

 

Biztonság 

Felhasználók kezelése 

A rendszer kétféle felhasználót kezel: 

 Rendszergazda: a kézikönyvben „admin” néven szerepel. A rendszergazda alapértelmezett elnevezése 
admin, és ez nem módosítható. Az admin teljes körű jogosultsággal rendelkezik, és az összes 
felhasználót és eszközt kezelni tudja. A rendszerben csak egy admin felhasználó lehet. 

 Közönséges felhasználó: a kézikönyvben „felhasználó” néven szerepel. A felhasználó csak az élőkép és 
a rögzített videó lejátszására jogosult. A rendszerben legfeljebb 32 közönséges felhasználó 
szerepelhet. 

A felhasználók kezelési felületén (a Setup > Security > User alatt) lehet felhasználót hozzáadni. 

A felhasználó sikeres hozzáadását követően a jelszót az új jelszó beírásával tudja módosítani, a felhasználó 
törléséhez pedig a felhasználónevet kell törölni. 

 MEGJEGYZÉS! 
 A jelszavakat csak az admin tudja módosítani. Egy bejelentkezett felhasználó felhasználónevének

vagy jelszavának módosítása kilépteti a felhasználót. A felhasználónak az új felhasználónevet,
illetve jelszót kell a bejelentkezéshez használnia. 

 Csak az admin tud felhasználókat hozzáadni vagy törölni. Egy bejelentkezett felhasználó törlése
kilépteti a felhasználót. Törölt felhasználó nem tud bejelentkezni. 

 

Biztonságos adatátvitel beállítása 

A biztonság garantálásához egy biztonságos csatornát kell az adatátvitel számára beállítani. 

 MEGJEGYZÉS!  
Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típust. 

 

1. Kattintson a Setup > Network > Port elemre. 

 
2. Írja be a portszámot a HTTPS Port szövegmezőbe. 

3. Kattintson a Save lehetőségre. 

4. Kattintson a Setup > Security > Network Security > HTTPS lehetőségre. 

 

5. A HTTPS beállításnál válassza az On lehetőséget. Szükség szerint egyedi SSL-tanúsítványt is 
importálhat. 
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6. Kattintson a Save lehetőségre. 

A legközelebbi bejelentkezéskor a biztonsági csatorna üzemmódra váltáshoz https://IP:HTTPS portszám 
formátumban adja meg a címet, például https://192.168.0.13:443. Ha az alapértelmezett HTTPS-portot 
használja, https://IP formában írja be. 

Hitelesítés  

Az RTSP (Real Time Streaming Protocol – Valós idejű folyamatos adatátviteli protokoll) egy alkalmazási 
rétegbeli protokoll. A hang és videó átviteléhez és vezérléséhez állítsa be az RTSP-hitelesítést a webes 
felületen. 

1. Kattintson a Setup > Security > Network Security > Authentication lehetőségre. 

 
2. Válasszon ki egy hitelesítési módot, majd kattintson a Save gombra. 

Gyártó adatainak elrejtése 

Beállíthatja a hálózati kamera gyártói adatainak elrejtését a webes felületen. 

1. Kattintson a Setup > Security > Registration Info lehetőségre. 

 
2. A Registration Info alatt válassza az On beállítást. 

3. Kattintson a Save lehetőségre. 

ARP-összekapcsolás 
Ez a funkció az ARP-támadásokkal szemben védi a kamerát. Ahhoz, hogy egy számítógép egy másik 
hálózatról elérhesse a kamerát, megfelelően be kell állítani az átjárót és a MAC-címet. Hibás MAC-cím 
beállítása esetén a kamerát csak az azonos hálózaton lévő számítógépek tudják elérni. 

1. Kattintson a Setup > Security > Network Security > ARP Protection lehetőségre. 

 

2. Az ARP-összekapcsolás engedélyezéséhez jelölje be a jelölőnégyzetet, majd állítsa be az átjáró 
MAC-címét. 

3. Kattintson a Save lehetőségre. 

IP-címszűrés 

Az IP-címszűrés beállításával engedélyezheti vagy tilthatja a megadott IP-cím(ek)ről történő hozzáférést. 

 MEGJEGYZÉS!  
Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típust. 

 

1. Kattintson a Setup > Security > Network Security > IP Address Filtering lehetőségre. 
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2. Válassz az On beállítását az IP-címszűrés engedélyezéséhez. 

3. Válasszon egy szűrési módot, majd adja hozzá az IP-címe(ke)t. 

4. Kattintson a Save lehetőségre. 

 MEGJEGYZÉS! 
 Ha a Filtering Mode beállítása Whitelist, akkor a kamera csak a hozzáadott IP-cím(ek)ről érhető el. 

Ha a Filtering Mode beállítása Deny Access, akkor a kamera csak a hozzáadott IP-cím(ek)ről nem 
érhető el. 

 Legfeljebb 32 IP-cím használata megengedett. Minden IP-címet csak egyszer lehet hozzáadni. 
 Minden IP-cím első bájtja 1 és 223 közötti lehet, és a negyedik nem lehet 0. A következő IP-címek 

például nem megengedettek, ezért nem adhatók a listához: 0.0.0.0, 127.0.0.1, 255.255.255.255,
224.0.0.1. 

 

Hozzáférési szabályzat 

 MEGJEGYZÉS! 
A könnyű jelszó használatának engedélyezése nincs hatással a használatra. Ha kikapcsolja ezt az opciót és
gyenge jelszóval jelentkezik be, akkor előugrik egy jelszava megváltoztatását kérő oldal. Az oldalon nincs
Mégse vagy Bezárás gomb. Az alapértelmezett jelszót a rendszer gyenge jelszóként kezeli. 

 

1. Kattintson a Setup > Security > Network Security > Access Policy lehetőségre. 

 
2. A telnet, könnyű jelszó és MAC-hitelesítés engedélyezéséhez válassza az On beállítást. 

3. Kattintson a Save lehetőségre. 

Vízjel 

Vízjelet használhat a videóval továbbított egyéni információk titkosításához, megakadályozva az illetéktelen 
törlést vagy módosítást. 

 MEGJEGYZÉS! 
Ezt a funkciót csak néhány kameratípus támogatja. 

 

1. Kattintson a Setup > Security > Watermark lehetőségre. 
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2. A vízjel engedélyezéséhez válassza az On beállítást, majd adja meg a vízjel tartalmát. 

3. Kattintson a Save lehetőségre. 

A rendszeridő beállítása 

Az eszköz rendszeridejét az alábbi módszerekkel állíthatja be. 

A rendszeridő kézi beállítása vagy szinkronizálása 

1. Kattintson a Setup > Common > Time lehetőségre, majd kattintson a Time fülre. 

  

2. Válasszon egy szinkronizálási módot. 

3. Állítsa be a megfelelő időzónát és rendszeridőt. A Sync with Computer Time elemre kattintva 
számítógépével is szinkronizálhatja a kamera időbeállításait. 

4. Kattintson a Save lehetőségre. 

Szinkronizálás az NTP-szerverrel 

1. Kattintson a Setup > Common > Time lehetőségre, majd kattintson a Time fülre. 

 
2. Az Sync Mode beállításnál válassz a Sync with NTP Server lehetőséget, majd állítsa be az NTP-szerver 

IP-címét, valamint a frissítési időközt. 

3. Kattintson a Save lehetőségre. A kamera rendszeres időközönként szinkronizálja az időt az 
NTP-szerverrel. 

A nyári időszámítás beállítása 

1. Kattintson a Setup > Common > Time lehetőségre, majd kattintson a DST fülre. 

 

2. A DST beállításnál válassza az On lehetőséget, állítsa be a kezdés időpontját, a befejezés időpontját és 
a nyári időszámítás eltérését. 
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3. Kattintson a Save lehetőségre. 

A szerverek beállítása 

Intelligens szerver 
Ha egy ultraérzékeny kamera kezelését egy központi szerver végzi, akkor be kell állítania egy intelligens 
szervert. 

 MEGJEGYZÉS! 
 Az intelligens szerver funkciót csak néhány kameratípus támogatja. 
 Az arc-pillanatfelvétel használatához el kell végezni annak a TMS-szervernek a konfigurálását,

amelyre a kamera a pillanatfelvételeket feltölti. 

 

1. Kattintson a Setup > Common > Server lehetőségre, majd kattintson az Intelligent Server fülre. 

 
2. Állítsa be a TMS-szerver IP-címét, majd végezze el a többi beállítást. 

3. Kattintson a Save lehetőségre. 

Soros port mód konfigurálása 

Az RS485 soros port a külső eszközzel történő adatcseréhez használható. A soros port kamerán lévő 
beállításainak meg kell egyezniük a külső eszköz beállításaival. 

 MEGJEGYZÉS! 
Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típust. 

 

PTZ-vezérlés 
Egy PTZ-kamera külső eszközön keresztül történő vezérléséhez a Port Mode beállításnál a PTZ Control 
lehetőséget kell választani.  

PELCO-D kompatibilis PTZ-vezérlő parancsokat az RS485-porton keresztül küldve a PTZ-vezérlőpanel 
használata nélkül vezérelheti a PTZ-kamerát. 

1. Kattintson a Setup > System > Ports & Devices lehetőségre, majd kattintson a Serial Port fülre. 



59 

  

2. A Port Mode legördülő listában válassza a PTZ Control lehetőséget. A következő táblázat néhány bőbb 
paramétert mutat be. 

Paraméter Leírás 

PTZ Protocol 

Itt állíthatja be a csatorna által támogatott PTZ-protokollt. 

Megjegyzés: 
 Ez a paraméter csak akkor állítható, ha a Port Mode beállítása PTZ Control.  
 Ha a PTZ Protocol beállítása INTERNAL-PTZ, akkor a kamera soros port nélkül 

csatlakoztatható külső PTZ-egységre (a soros port paraméterei ki vannak szürkítve). Ilyen 
esetben csak a kamera zoom és élességállítási interfészeit kell az objektívhez 
csatlakoztatnia, és úgy tudja a PTZ-kamerát működtetni, akár egy belső PTZ-kamerát. 

PTZ Mode 

 Beépített PTZ prioritása: Ennek az opciónak a kiválasztása esetén a kamera a külső 
PTZ-funkció helyett először megkísérli önállóan vezérelni a PTZ-funkciókat (például a 
zoomot és az élességállítást). Azokhoz a műveletekhez, amelyeket a kamera nem képes 
önállóan végrehajtani, a külső PTZ-funkciót használja. 

 Külső PTZ prioritása: A kamera először a soros porton keresztül csatlakoztatott 
PTZ-interfészen keresztül próbálja a PTZ-funkciókat vezérelni. 

Megjegyzés: 
 Ez a paraméter csak akkor állítható, ha a Port Mode beállítása PTZ Control. 
 Ha az INTERNAL-PTZ van kiválasztva, akkor ez a paraméter mindig Built-in PTZ Priority 

értékre van állítva, és a kamerát nem szükséges a soros porton keresztül külső 
PTZ-interfészre csatlakoztatni. A külső PTZ-interfészen keresztül történő vezérlés akkor is 
hatástalan, ha a kamera külső PTZ-interfészre csatlakozik. 

 Szükség szerint állítsa be ezt a paramétert. Győződjön meg arról, hogy a PTZ-vezérléshez 
kapcsolódó interfészek megfelelően csatlakoznak. 

Address Code 

Itt állíthatja be a PTZ-vezérlés címkódját. 

Megjegyzés: 
Ez a paraméter csak akkor állítható, ha a Port Mode beállítása PTZ Control és a PTZ 
Protocol beállítása nem INTERNAL-PTZ. 

 

3. Kattintson a Save lehetőségre. 
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Transzparens csatorna 
Az RS485 soros porton keresztül transzparens adatátvitelt hozhat létre a külső eszközzel. A transzparens 
csatornát főként két eszköz közötti transzparens adatátvitelhez használják. 

 MEGJEGYZÉS!  
 Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típust. 
 Ellenőrizze, hogy a Port Mode paraméter a kamerán Trans-Channel beállítású-e. 

 

1. Kattintson a Setup > System > Ports & Devices lehetőségre, majd kattintson a Serial Port fülre. 

 
2. A Port Mode legördülő listában válassza a Trans-Channel lehetőséget. 

3. A Trans-Channel beállításnál jelölje be az Enable opciót. 

4. Adja meg a cél IP-címet és portszámot (azt az IP-címet és portszámot, amelyre a transzparens csatorna 
csatlakozik). 

5. Kattintson a Save lehetőségre. 

OSD 

Ha az OSD-n szeretné a külső eszköz információit megjeleníteni, a port módnál válassza az OSD lehetőséget. 

A kamera az RS485 soros porton keresztül megkapja az információkat a külső eszköztől, majd az OSD-n 
megjeleníti azokat. 

 MEGJEGYZÉS! 
Ahhoz, hogy a kamera helyesen értelmezze a külső eszköztől kapott információkat, gondoskodjon arról,
hogy a külső eszköz által a soros porton keresztül küldött információk megfelelnek a vállalatunk által
megadott adatformátumnak. További részletekért forduljon a forgalmazójához. 

 

1. Kattintson a Setup > System > Ports & Devices lehetőségre, majd kattintson a Serial Port fülre. 
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2. A Port Mode legördülő listában válassza az OSD lehetőséget. Jelölje be az Enable OSD Report opciót 
(hogy megtörténjen az OSD-adatok feltöltése a platformra). 

3. Kattintson a Save lehetőségre. 

ONVIF transzparens csatorna 
Adatok átvitele a transzparens csatornán (ONVIF) keresztül a kamera RS485-portja és egy külső eszköz 
között. 

1. Kattintson a Setup > System > Ports & Devices lehetőségre, majd kattintson a Serial Port fülre. 

 

2. A Port Mode beállításnál válassza a Select Trans-Channel via ONVIF lehetőséget. 

3. Kattintson a Save lehetőségre. 

Az ablaktörlő vezérlése 

Az ablaktörlő vezérléséhez be kell állítani az ablaktörlő paramétereit. 

 MEGJEGYZÉS!  
Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típust. 

 

1. Kattintson a Setup > System > Ports & Devices lehetőségre, majd kattintson az External Device fülre. 
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2. Állítsa be az ablaktörlő vezérlési módját. A következő táblázat néhány bőbb paramétert mutat be. 

Paraméter Leírás 

Serial Port Az ablaktörlő vezérlése PELCO-D utasításokkal történik, ezért a PTZ-protokollt PELCO-D 
értékre kell állítani. A részleteket lásd: PTZ-vezérlés. 

Alarm 
Input/Output 

A riasztási bemenetet és kimenetet használhatja az áramkör nyitására vagy zárására és az 
ablaktörlő vezérlésére. 

 

Az eszköz állapotának megtekintése 

Megtekintheti a kamera pillanatnyi állapotát. 

1. Kattintson a Setup > Common > Basic Info lehetőségre. 

2. A legfrissebb állapotinformációkhoz kattintson a Refresh elemre. 

3. Olvassa le az eszközinformációkat. 

Fotótároló állapota 

Megtekintheti a fotótároló pillanatnyi állapotát. A tárolóra vonatkozó teljes körű szabályokat lásd: Tárolás 
memóriakártyán. 

 MEGJEGYZÉS!  
Ezt a funkciót csak a tárhely funkcióval ellátott típusok támogatják. Részletekért lásd a tényleges típust. 

 

1. Kattintson a Photo lehetőségre. 
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2. A tároló állapotának frissítéséhez kattintson a Refresh elemre. 

3. Exportálhatja vagy törölheti az Image List lévő fotókat. 

Az eszköz frissítése 

Ha az eszköz kezelését a központi kezelőszerver végzi, és Ön kötegelt módban szeretné az eszközöket 
frissíteni, akkor javasolt a frissítési műveletet a központi szerveren elvégezni. A részletes lépésekre 
vonatkozóan lásd a központi kezelő szerver felhasználói kézikönyvét. 

1. Kattintson a Setup > System > Maintenance lehetőségre. 

 
2. A Software Upgrade alatt kattintson a Browse gombra, majd válassza ki a megfelelő frissítőfájlt. 

3. Kattintson az Upgrade gombra, majd erősítse meg a művelet indítását. A frissítés befejeződését 
követően a kamera automatikusan újraindul. Egyes eszközök támogatják az indítóprogram frissítését. 
A frissítéshez jelölje be az Upgrade Boot Program opciót. 

4. A Detect gombra kattintva ellenőrizheti a felhőből történő frissítéshez elérhető új verziókat. 

 MEGJEGYZÉS! 
 A kamerához megfelelő frissítőfájlt kell használnia. Ellenkező esetben váratlan hibák léphetnek fel.
 A frissítőfájl egy ZIP fájl, amelynek az összes szükséges fájlt tartalmaznia kell. 
 Az indítóprogram betölti az operációs rendszert, majd a rendszer elindul. Az indítóprogram 

frissítése funkció alapértelmezett esetben le van tiltva, és csak a kameraszoftver frissül a legújabb
verzióra. Ha engedélyezve van, akkor a kameraszoftver és az indítóprogram is frissül, és a későbbi,
új verziójú operációs rendszerek megfelelően indíthatók, a kamera pedig kényelmesen frissíthető. 

 Ügyeljen arra, hogy a frissítés alatt a tápellátás megfelelő legyen. A frissítés befejeződését
követően az eszköz újraindul. 

 

A rendszer újraindítása 

1. Kattintson a Setup > System > Maintenance lehetőségre. 

 
2. A Device Restart részben kattintson a Restart gombra. A művelet megerősítését követően az eszköz 

újraindul.  

 
FIGYELEM! 
Ennek a műveletnek a végrehajtásakor körültekintéssel járjon el, mert a rendszer újraindítása megszakítja
a folyamatban lévő szolgáltatást. 

 

A rendszerbeállítási fájl importálása és exportálása 

Exportálhatja, és számítógépre vagy külső adathordozóra mentheti a kamera aktuális beállításait. A 
számítógépen vagy külső adathordozón tárolt, mentett beállítások importálásával pedig gyorsan 
visszaállíthatja a kamera beállításait. 
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FIGYELEM!  

 A Default művelet végrehajtását követően minden beállítás az alapértelmezett gyári értékre áll
vissza, a következők kivételével: a rendszergazda bejelentkezési jelszava, a hálózati beállítások,
valamint a rendszeridő. 

 Győződjön meg arról, hogy a megfelelő beállítási fájlt importálja a kamerára. Ellenkező esetben
váratlan hibák léphetnek fel. 

 A beállítási fájl sikeres importálását követően a kamera újraindul. 

 

1. Kattintson a Setup > System > Maintenance lehetőségre. 

 

2. A mentett beállítások importálásához kattintson az Import gomb melletti Browse gombra, válassza ki 
az importálni kívánt beállításokat, majd kattintson az Import gombra. Megjelenik a művelet 
eredménye. 

3. A beállítások exportálásához kattintson az Export gombra, majd válassza ki a célmappát. 

4. Az alapértelmezett beállítások visszaállításához kattintson a Default gombra, majd erősítse meg a 
műveletet. Az eszköz újraindul, és visszaállítja az alapértelmezett beállításokat. 

Diagnosztikai információk gyűjtése 

A diagnosztikai információk naplókat és rendszerbeállításokat tartalmaznak. A diagnosztikai információkat 
számítógépére exportálhatja. 

1. Kattintson a Setup > System > Maintenance lehetőségre. 

 

2. A Diagnosis Info részben kattintson az Export gombra, majd válassza ki a célmappát. 

 MEGJEGYZÉS! 
 A diagnosztikai információk exportálása tömörített fájl formájában, a helyi mappába történik. A

fájlt egy szoftvereszköz, például WinRAR segítségével ki kell csomagolnia, majd az így kapott fájlt
egy szövegszerkesztővel kell megnyitni. 

 A Collect Image Debugging Info opció bejelölésével a videót a javítási információkkal egyidejűleg
jelenítheti meg, ami megkönnyíti a hibajavításokat. 

Élességállítás beállítása 

Az eszköz képes a minimális fókusztávolságnak megfelelően beállítani az automatikus élességállítás 
sebességét. Az éles felvételek érdekében javasolt a minimális fókusztávolságot az objektív és a tárgy közötti 
távolságnál közelebbre állítani, például ha a minimális fókusztávolság 3 m, akkor az objektívtől 3 méteren 
belüli tárgyak életlenek lesznek. 
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 MEGJEGYZÉS! 
Ez a funkció csak automatikus élességállítás funkcióval ellátott eszközökön érhető el. Részletekért lásd a
tényleges típust. 

1. Kattintson a Setup > System > Maintenance lehetőségre. 

 

2. A Focus részben állítsa be a Min. Focus Distance (cm-ben) és Max. Zoom Ratio értékeket. 

3. Kattintson az OK gombra. 

Az eszköz felszerelési magassága 

Itt adhatja meg a felszerelt infravörös dóm talaj fölötti magasságát annak érdekében, hogy a dóm 
automatikusan be tudja állítani az infravörös fényforrást. 

 MEGJEGYZÉS! 
Ezt a funkciót csak egyes infravörös kamerák támogatják. Részletekért lásd a tényleges típust. 

1. Kattintson a Setup > System > Maintenance lehetőségre. 

 

2. Adja meg a dóm talaj fölötti tényleges magasságát. 

3. Kattintson az OK gombra. 

Halszemkamera-paraméterek 

A videokép megfelelő megjelenítéséhez megfelelően be kell állítania a tényleges felszerelési módnak 
megfelelő halszemparamétereket. 

 MEGJEGYZÉS! 
Ezt a funkciót csak halszemkamerát támogatják. Részletekért lásd a tényleges típust. 

 

1. Kattintson a Live View > Mount lehetőségre. Válassza ki a felszerelési módot. A választott felszerelési 
módnak meg kell egyeznie a tényleges felszerelési móddal. 
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Egyes kameratípusok esetén az oldal az alábbiaknak megfelelően néz ki. 

 

 

2. Állítsa be a paramétereket. A következő táblázat néhány bőbb paramétert mutat be. 
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Paraméter Leírás 

 

 

 

 

 

 

 

 

 

 

 

Tizenegyféle megjelenítési mód: 

 Eredeti kép 
 Panoráma 
 Panoráma+3PTZ 
 Panoráma+4PTZ 
 Panoráma+8PTZ 
 360°-os panoráma+1PTZ 
 180°-os panoráma 
 Halszem+3PTZ 
 Halszem+4PTZ 
 360°-os panoráma+6PTZ 
 Halszem+8PTZ 

 

 

 

Háromféle felszerelési mód: 

• Mennyezeti 

• Fali 

• Asztali 

Megjegyzés: 
A választott felszerelési módnak meg kell egyeznie a tényleges felszerelési móddal. 

 

4  Élőkép 

Az élőkép a kamerából érkező élő videó (valós idejű hang és videó) webes felületen lévő ablakban történő 
lejátszását jelenti. 

Ha bejelentkezéskor a Live View jelölőnégyzet be van jelölve, akkor bejelentkezéskor alapértelmezett 
esetben megjelenik az élőkép. Az ablakra duplán kattintva léphet teljes képernyős módba, illetve léphet ki 
belőle. 
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Élőkép eszköztár 

 MEGJEGYZÉS! 
A támogatott élőképműveletek kameratípustól függően eltérőek lehetnek. A kamera által támogatott
műveletekre vonatkozóan lásd a webes felületet. 

 

Gomb Leírás 

/  Élő videokép lejátszása/leállítása. 

 A számítógép médialejátszója kimeneti hangerejének beállítása. 

 
A számítógép-mikrofon hangerejének beállítása a számítógép és a kamera 
közötti hangkommunikáció közben. 

 

Pillanatfelvétel készítése a számítógépen éppen megjelenített képről. 

Megjegyzés:  
A pillanatfelvételek mentési útvonala a System Configuration alatt állítható be. 

/  

Helyi rögzítés indítása/leállítása. 

Megjegyzés:  
A helyi felvételek mentési útvonala a System Configuration alatt állítható be. 

/  A számítógép és a kamera közötti hangkommunikáció indítása/leállítása. 

/  
Digitális zoom indítása/leállítása. További részletek itt: A digitális zoom 
használata. 

/  
Területi élességállítás indítása/leállítása. További részletek itt: Területi 
élességállítás használata. 

/  
3D pozícionálás indítása/leállítása. További részletek itt: 3D pozícionálás 
használata. 

 PTZ-vezérlőpult megjelenítése/elrejtése. 
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Gomb Leírás 

 

A kép megjelenítési arányának beállítása az ablakban. A nagy felbontású képek 
eredeti, 16:9 arányú megjelenítéséhez például válassza a Scale lehetőséget, az 
ablak méretéhez igazított megjelenítéshez válassza a Stretch beállítást, az 
eredeti méretben történő megjelenítéshez pedig válassza az Original opciót. 

 

Csomagvesztési arány nullára csökkentése. 

Megjegyzés:  
Ez a gomb a kurzor élőképen történő mozgatását követően, a lebegő 
eszköztáron jelenik meg. 

 

A csomagvesztési arány és a bitsebesség-adatok megjelenítése az ablak alsó 
részén. 

Megjegyzés: 
Ez a gomb a kurzor élőképen történő mozgatását követően, a lebegő 
eszköztáron jelenik meg. 

Erre a gombra kattintva az információk mindig láthatók. Újabb kattintás 
hatására az információk csak a kurzor ablak fölött történő mozgatása közben 
vagy a kurzort az ablak aljára helyezve jelennek meg. Ha az egérmutató 
körülbelül 3 másodpercig mozdulatlan marad az ablak fölött vagy elhagyja az 
ablakot, az információk eltűnnek. 

 Erre a gombra kattintva megjelenik a képbeállítás oldal.  

 Megjelenítés teljes képernyős módban. 

 

 

 

Itt választhat a kamera által támogatott élő video-adatfolyamok közül: 
fő adatfolyam, második adatfolyam vagy harmadik adatfolyam. 

 

A kép bizonyos részeinek megtekintése 
A digitális zoom, a területi élességállítás és a 3D pozícionálás funkciók lehetővé teszik a képek bizonyos 
részeinek részletesebb megjelenítését. A digitális zoom a képminőség romlása mellett nagyít fel egy képet, 
míg a 3D pozícionálás minőségromlás nélkül nagyítja a képet. 

A digitális zoom használata 

 MEGJEGYZÉS! 
A támogatott élőképműveletek kameratípustól függően eltérőek lehetnek. A kamera által támogatott
műveletekre vonatkozóan lásd a webes felületet. 

 

1. A Live View oldalon kattintson az eszköztáron lévő  gombra. 
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2. Kattintson rá, majd tartsa nyomva az egérgombot, és húzza felülről lefelé (rajzoljon egy téglalapot) a 

terület kijelöléséhez. Az eredeti képméret visszaállításához és a kép más területeinek kinagyításához 
kattintson a jobb egérgombbal. 

3. A kilépéshez kattintson a  gombra. 

Területi élességállítás használata 

 MEGJEGYZÉS! 
A támogatott élőképműveletek kameratípustól függően eltérőek lehetnek. A kamera által támogatott
műveletekre vonatkozóan lásd a webes felületet. 

 

1. A Live View oldalon kattintson az eszköztáron lévő  gombra. 
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2. Kattintson rá, majd tartsa nyomva az egérgombot, és húzza felülről lefelé (rajzoljon egy téglalapot) a 
terület kijelöléséhez. 

3. A kilépéshez kattintson a  gombra. 

3D pozícionálás használata 

 MEGJEGYZÉS! 
Ez a funkció csak hálózati PTZ-kamerákon és motoros zoom objektívvel és PTZ-funkcióval ellátott hálózati 
box kamerákon érhető el. Részletekért lásd a tényleges típusokat. 

 

1. A Live View oldalon kattintson az eszköztáron lévő  gombra. 

 
2. Kattintson rá, majd tartsa nyomva az egérgombot, és húzza felülről lefelé (rajzoljon egy téglalapot) a 

terület kijelöléséhez. Visszafelé húzva (lentről felfelé) csökkentheti a nagyítást. 

3. A kilépéshez kattintson a  gombra. 

Halszemkamerák élőképe 

 MEGJEGYZÉS! 
 Ez a funkció csak hálózati halszemkamerákon támogatott. Részletekért lásd a tényleges típusokat. 
 A weben látható előnézeti kép a kamera halszembeállításaitól függően különböző lehet. Az élőkép 

indítása előtt állítsa be a kamerán a halszemparamétereket (lásd: Halszemkamera-paraméterek) 
és a halszem módot (lásd: Videobeállítások).  

A megjelenítési módok három fő típusra oszthatók: Eredeti kép, Halszem és PTZ, Panoráma és PTZ. A 
különböző felszerelési módok esetén a képek különbözőképpen jelennek meg. A következőkben a fali 
rögzítés szerepel példaként. 

Az eredeti kép kiválasztása esetén a halszemképek az alábbi módon jelennek meg. 
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A Panoráma nézet kiválasztása esetén a kiegyenesített panorámaképek az alábbi módon jelennek meg. 
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MEGJEGYZÉS! 
Mennyezetre rögzítés vagy asztalra rögzítés alkalmazása esetén a panorámakép (két 180°-os kép) a 
halszem előnézeti képének (360°-os kép) kiegyenesített képe. Úgy szerelje fel a kamerát, hogy a látószög
a tényleges térfigyelési igényekhez igazodjon. 
Ha például a kamera a mennyezetre van felszerelve, akkor a megfigyelt célpont a panorámakép felső 
részén jelenik meg, amennyiben az eszköz kábelkimenete (logó) és a megfigyelt célpont közötti
metszésszög az óramutató járásával megegyező irányban 135°. 
 

LOGO

Cable 
outlet

45°

Position of surveillance target
(e.g. access control)

Target

Target

Device 
bottom

360° Fisheye image in 
fisheye preview mode

Panorama image in 
panorama preview mode

 
 

Ha a jobb oldali listából a Panoráma + 4 PTZ előnézet mód van kiválasztva, akkor 4 helyi kép jelenik meg, 
alapértelmezett esetben balról jobbra, felülről lefelé haladva. Mindegyik helyi képen végezhet PTZ-vezérlési 
és zoom műveleteket, ahogy az alábbi képen látható. 

 

 
360° halszemkép halszem 

előnézet módban 
Panorámakép panoráma 

előnézet módban 
Megfigyelt célpont  

(pl. hozzáférés-vezérlés) 

Célpont 
Célpont

Kábel- 
kimenet 

Eszköz talpa 

LOGÓ 
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5  Videó lejátszása és letöltése az Edge tároló 
segítségével 

 MEGJEGYZÉS! 
 Az Edge tároló funkció a videó első vonalbeli eszköz (általában kamera) memóriakártyáján történő

tárolást jelenti. A helyi rögzítés a videó helyi kliensszámítógépre történő rögzítését jelenti. 
 Ha az edge tároló segítségével szeretne videót lejátszani, ellenőrizze, hogy a kamerában

van-e memóriakártya behelyezve, és a tárhely megfelelően konfigurálva van-e. 
 Ezt a funkciót egyes típusok nem támogatják. Részletekért lásd a tényleges típusokat. 

 

Videó lejátszása 
1. A kezdőoldalon kattintson a Playback gombra. 

 

2. Válassza ki a dátumot a naptárból. 

3. Kattintson a Query gombra. 

4. A Results rész alatt kattintson duplán a kívánt időintervallumra a felvétel lejátszásához. 

Letöltés 
1. A kezdőoldalon kattintson a Playback gombra. 
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2. Keresse meg a videót a megadott időintervallumon belül. A találatok megjelennek egy listában. 

3. Válassza ki a videót, majd kattintson a Download gombra. A videó letöltődik a memóriakártyából helyi 
mappába (a helyi mappa a Local Settings beállításainál módosítható). 

4. Az Open lehetőségre kattintva megjelenik a videó letöltési mappája. 

6  PTZ-vezérlés 

Ez a funkció kizárólag PTZ dómkamerák vagy pásztázó/dőlésszögvezérlő motorra szerelt box kamerák 
esetén érhetők el.  

 MEGJEGYZÉS! 
 Egyes objektívvezérlő funkciók motoros objektívvel felszerelt kamerákra érvényesek. 
 A PTZ-vezérlőgombok kameratípustól függően többfélék lehetnek. A kamera által támogatott

PTZ-vezérlőgombokkal kapcsolatban lásd a webes felületet. 

 

PTZ-vezérlési eszköztár 

Tétel Leírás 

Preset 

Válasszon ki egy presetet, majd kattintson a  gombra. A PTZ-kamera a 
kiválasztott preset pozícióba mozog. 

Preset hozzáadásához kattintson a  gombra. Egy preset törléséhez kattintson a 
 gombra. 

Patrol 

Válasszon ki egy őrjárati útvonalat, majd kattintson a  gombra az őrjárat 
indításához.  

 Egy őrjárati útvonal szerkesztéséhez kattintson a  gombra. 

 Őrjárati útvonal hozzáadásához kattintson a  gombra. 

 Egy őrjárati útvonal törléséhez kattintson a  gombra. 

 

Itt állíthatja be a PTZ-kamera mozgási sebességét. 



76 

Tétel Leírás 

 

Itt vezérelheti a PTZ-kamera mozgásának irányát, valamint állíthatja le a 
vezérlést. 

/  

/  

/  

/  

/  

IR be-/kikapcsolása. 

Az ablaktörlő be-/kikapcsolása. 

A fűtés be-/kikapcsolása. 

Világítás be-/kikapcsolása. 

Hómentesítés be-/kikapcsolása. 

 
A kamera élességének állítása. 

 
Kamera zoom állítása. 

 
Rekeszátmérő növelése vagy csökkentése. 

 

PTZ-vezérlés gyorsbillentyűi. Miután az egérkurzor az élőképen az alakzatok 
egyikére vált, a bal egérgomb lenyomásával és nyomva tartásával vezérelheti a 
PTZ-kamerát. 

Megjegyzés: 
 Ezt a funkciót csak PTZ dómkamerák és PTZ-kamerák támogatják. 
 Ezek a gombok 3D pozícionálás és digitális zoom használata közben nem 

használhatók. 

 

Gyorsbillentyűk az élőképen végzett nagyításhoz és kicsinyítéshez. Az egérgörgőt 
előregörgetve nagyíthatja, hátrafelé görgetve pedig kicsinyítheti a képet. 

Megjegyzés: 
Ezt a funkciót csak motoros zoom objektívvel ellátott kamerák támogatják. 

 

Őrjárat preseteken keresztüli beállítása 

Presetek beállítása 

A Preset lapon kezelheti a preseteket vagy végezhet bizonyos vezérlési műveleteket a PTZ-kamerán. További 
részletek itt: PTZ-vezérlési eszköztár. 

Preset hozzáadása 

1. A Live View oldalon kattintson a vezérlőpulton lévő Preset lehetőségre. 
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1

2

3

4

 
2. Állítsa be a kamerát, hogy a kívánt irányba nem nézzen. 

3. Állítsa be az optimális képhez szükséges zoomot és élességet. 

4. A beállítás presetként történő hozzáadásához kattintson a  gombra. Adjon egy számot és egy nevet a 
presetnek, majd kattintson az OK gombra. 

Presetre ugrás 

1. A Live View oldalon kattintson a vezérlőpulton lévő Preset lehetőségre. 

1 2

 

2. Kattintson a kívánt preset mellett lévő  gombra. A PTZ-kamera a kiválasztott preset pozícióba 

mozog. 

Előbeállítás törlése 

1. A Live View oldalon kattintson a vezérlőpulton lévő Preset lehetőségre. 
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2. Kattintson a kívánt preset mellett lévő  gombra, majd erősítse meg a törlést. 

Őrjárat beállítása 

Őrjárati útvonalnak nevezzük azt az útvonalat, amelyet egy PTZ-kamera követ, amikor egyik presetről a 
másikra mozog. A PTZ-kamera által az egyes presetekben töltött idő beállítható. Egy PTZ-kamerához több 
őrjárati útvonal is beállítható. 

Az őrjárati műveletek egy presetre mozgást, egy bizonyos ideig a preseten maradást, majd a következő 
presetre mozgást jelentik. Beállíthatja a forgás irányát, a zoomot, a forgási sebességet, az őrjárat idejét és 
az egy helyben maradást idejét. A rendszer rögzíti az útvonalat, majd a műveletlistához adja. A Keep 
Rotating mező bejelölésével a PTZ-kamera ugyanazt az útvonalat követve ismétlődően végzi az őrjáratot. 

Őrjárati útvonal hozzáadása 

1. A Live View oldalon kattintson a vezérlőpulton található Patrol elemre. 

 
2. Kattintson a  ikonra. 
3. Az Add Patrol oldalon adja meg az útvonal azonosítóját és nevét, majd az Add gombra kattintva adjon 

hozzá egy őrjárati műveletet. Legfeljebb 64 művelet megengedett. Ha a művelet típusa Move 
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Direction és Zoom, akkor minden sor két műveletet tartalmaz, így ekkor 32 művelet megengedett.  
A gombokkal állíthatja be a műveletek sorrendjét. 

Az őrjárati műveletek a következőket tartalmazzák: 

 Presetre mozgás, egy bizonyos ideig a egy helyben maradás, majd a következő presetre mozgás. 

 Megadott sebességgel, megadott irányban, meghatározott ideig történő forgatás, zoomolás, megadott 
ideig egy beállított pozícióban maradás, vagy folyamatos őrjáratozás, ha a Keep Rotating be van 
jelölve. 

Javasoljuk, hogy az első művelet típusa Go to Preset legyen. 

4. Kattintson az OK gombra. 

Őrjárati útvonal rögzítése 

1. A Live View oldalon kattintson a vezérlőpulton található Patrol elemre. 

1

2

 

2. Az őrjárati útvonal rögzítésének indításához kattintson a  gombra. Rögzítés közben állíthatja a 

kamera irányát és a zoomot. A rendszer rögzíti a mozgást, valamint a kamera útvonalát, majd 
hozzáadja a listához. 

3. A rögzítés leállításához kattintson a  gombra. A rendszer automatikusan menti az őrjárati útvonalat. 
A  gombra kattintva elindíthatja az őrjáratot, illetve a  gombbal törölheti az útvonalat. 
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Őrjárati időterv készítése 

1. A Live View oldalon kattintson a vezérlőpulton található Patrol elemre. 

1

2
 

2. Kattintson a  ikonra. Megjelenik az őrjárati időtervek beállításának oldala. 

3. Állítsa be a megfelelő őrjárati időt és útvonalat. 

4. Jelölje be az Enable Patrol Plan opciót. 

5. Kattintson az OK gombra. 

Őrjárati útvonal indítása 

Egy őrjárati útvonal hozzáadását követően válassza ki az útvonalat az őrjárat elindításához. 

1. A Live View oldalon kattintson a vezérlőpulton található Patrol elemre. 
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2. Kattintson az indítani kívánt őrjárati útvonal mellett lévő  gombra. 

Őrjárati útvonal szerkesztése 

1. A Live View oldalon kattintson a vezérlőpulton található Patrol elemre. 

 

2. Kattintson a szerkeszteni kívánt őrjárati útvonal melletti  gombra, majd szükség szerint módosítsa a 
beállításokat. 

Őrjárati útvonal törlése 

1. A Live View oldalon kattintson a vezérlőpulton található Patrol elemre. 
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2. Kattintson a törölni kívánt őrjárati útvonal melletti  gombra, majd erősítse meg a törlést. 

Kezdőpozíció beállítása 
Ha egy megadott ideig nem történik művelet, a PTZ-kamera visszatér a kezdőpozícióba. 

 MEGJEGYZÉS! 
 Ez a funkció csak hálózati PTZ-kamerák esetén érhető el. 
 Először preseteket, valamint egy őrjárati útvonalat kell beállítania. Részletek: Preset hozzáadása és Őrjárati 

útvonal hozzáadása. 

 

1. Kattintson a Setup > PTZ > Home Position lehetőségre. 

 
2. Válasszon egy üzemmódot és egy azonosítót. 

3. Kattintson a Save lehetőségre. 

Távirányított PTZ 
Más gyártó platformjának használata esetén, amennyiben a PTZ-protokoll nem egyezik a platformmal, 
beállíthatja a távirányítás funkciót a PTZ-funkció vezérléséhez. 

 MEGJEGYZÉS! 
Ez a funkció kizárólag PTZ-kamerákon támogatott. 

 

1. Kattintson a Setup > PTZ > Remote Control lehetőségre. 
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2. A Remote Control funkció engedélyezéséhez válassza az On beállítást. Állítsa be a figyelő portot és a 

címkódot. A következő táblázat néhány bőbb paramétert mutat be. 

Rövidítés Leírás  

Listener Port A kamera helyi portja, amely nem lehet már használatban lévő port. Csak 
szükség esetén módosítsa az alapértelmezett beállításokat. 

Address Code 
A kamera kiolvassa az utasításokban szereplő címkódot. A kamera csak akkor 
értelmezi az utasítást, ha az abban lévő címkód megegyezik az itt beállított 
címkóddal. 

 

3. Kattintson a Save lehetőségre. 

PTZ-végállás 
Beállíthat forgási végállásokat annak érdekében, hogy a PTZ-kamera ne ütközzön akadályoknak, például a 
falnak. 

 MEGJEGYZÉS! 
Ezt a funkciót nem minden PTZ-kamera támogatja. 

 

1. Kattintson a Setup > PTZ > PTZ Limit lehetőségre.  

 
2. Az iránygombokkal forgassa a kamerát a kívánt pozícióba. 
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3. Kattintson a  gombra az aktuális pozíció végállásként történő beállításához. Például a felső  

gombra kattintva állíthatja be a felső végállást. A  gombra kattintva forgathatja a kamerát a jelenlegi 

pozícióba, amennyiben a forgásirány megváltozott. 

4. Ismételje meg a fenti lépéseket az összes végállás szükség szerinti beállításához (fent, lent, balra, 
jobbra). 

5. Kattintson a Save lehetőségre. 

6. A beállítás alkalmazásához kattintson a Start PTZ Limit gombra. 

7. A beállítások törléséhez és a végállás alaphelyzetbe állításához kattintson a  gombra. 

Őrjárat folytatása 
1. Kattintson a Setup > PTZ > Patrol lehetőségre. 

 

2. Állítsa be az őrjárat folytatásának idejét. 

3. Kattintson a Save lehetőségre. 

 

 

„A” függelék – Névmutató 

Rövidítés Leírás  

ARP Címfeloldási protokoll 

CBR Állandó bitsebesség 

DNS Domainnév-szolgáltatás 

DDNS Dinamikus domainnév-szolgáltatás 

DHCP Dinamikus állomáskonfiguráló protokoll 

DST Nyári időszámítás 

FTP Fájlátviteli protokoll 

GOP Képcsoport 

GUI Grafikus felhasználói felület 

HTTPS SSL-titkosításon keresztüli hipertext átviteli protokoll 

IE Internet Explorer 

IMOS IP multimédia operációs rendszer 

IP Internetprotokoll 
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Rövidítés Leírás  

IPC IP-kamera 

MTU Maximális átviteli egység 

NTP Hálózati időprotokoll  

OSD Képernyőmenü 

PoE Energiaellátás Ethernet-kábelen keresztül 

PPPoE Pont-pont protokoll 

PTZ Pásztázás, dőlés, zoom 

ROI Érdekeltségi tartomány 

SMTP Egyszerű levélátviteli protokoll 

SSL Biztonsági alréteg 

UNP Univerzális hálózati passport 

USB Univerzális soros busz 

VBR Változó bitsebesség 

WDR Széles dinamikatartomány 

 

„B” függelék – GY.I.K. 

Mi a teendő, ha egy Windows 7 rendszert futtató számítógépről történő első bejelentkezéskor nem jelenik 
meg az ActiveX telepítésére vonatkozó üzenet? 

Válasz: Kövesse az alábbi lépéseket a Felhasználói fiókok felügyelete kikapcsolásához, majd jelentkezzen be 
ismét:  

1. Kattintson a Start gombra, majd a Control Panel lehetőségre. 

2. Írja be a keresőmezőbe az uac kifejezést, majd kattintson a Change User Account Control Settings 
lehetőségre.  

3. Állítsa a csúszkát a Never Notify pozícióba, majd kattintson az OK gombra.  

4. A Felhasználói fiókok felügyelete funkció kikapcsolását követően jelentkezzen be ismét. 
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Mi a teendő, ha az ActiveX telepítése nem sikerült? 
Válasz: Ha a telepítés nem sikerült, akkor vegye fel a kamera IP-címét a megbízható helyek közé: nyissa meg 
az IE Internet Option menüjét, kattintson a Security fülre, kattintson a Trusted sites lehetőségre, majd a 
Sites elemre kattintva adja hozzá a weboldalt.  

Windows 7 használata esetén először mentse a setup.exe fájlt a számítógépre, jobb egérgombbal 
kattintson a fájlra, válassza a Run as administrator lehetőséget, ezután az utasításokat követve végezze el a 
telepítést. 

 

Mi a teendő, ha első bejelentkezéskor az élő videokép nem működik? 

Válasz: Kapcsolja ki a tűzfalat számítógépén, majd jelentkezzen be ismét a webes felületre. 
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